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General Information

1.1

Overview
The DCR Player is a no-cost application, available from BIS Digital Inc.’s web site, and provides playback
facilities for the audio and video streams recorded in a Digital Recording file (i.e. a .dcr file). To obtain more
detailed information about the features of the DCR Player, review the “Features” section.
The following shows the main window of DCR Player.

1.2

Features
Some of the key features of the DCR Player are listed below:
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Playback of audio and video recordings, including a file that is currently being mirrored and files streamed
over an IP network.
Ability to play any combination of one or more channels.
Bookmarks allow you to navigate quickly in a sound file and store notes at chosen positions in a sound file.
Special bookmarks called dockets or cases can be used to identify case-related information.
Ability to work with file attachments. You can open attachments, delete attachments, seal/unseal
attachments, and optionally include them when exporting recording files.
Ability to redact files so that redacted segments can be omitted from playback and when exporting. A
redacted segment can be played, skipped, or blacked out. Video in a redacted segment can be distorted.
File notes can be added to a recorded file.
Digital certificates can be used to ensure recordings have not been altered.
An assistive view is available to comply with Section 508 of the Rehabilitation Act.
File notes and bookmarks can be exported as a text file, copied to the clipboard, or printed. You can choose
which data fields to include.
DCR Player supports many different types of flexible export operations. For example, you can export a file, or
part of a file, directly to an audio CD or video DVD (MPEG-2 format), or to a WMV, WAV, AVI or DCR file with
any combination of channels, and optionally with video.
Export a file, including bookmarks, audio, video, and attachments to PDF format. The media file can be
created and saved separately from the PDF document so that the audio/video links will work properly after
you move the file onto a Windows Media Server folder to be streamed to the end users.
Create a portable version of a recording file by exporting a dcr file, or part of a file, to MP4 format with the
metadata. This allows you to use a browser of your choice to play the video, listen to the audio, and use
bookmarks within the file.
The Channel Activity Detector (CAD) can be used to automatically insert a bookmark into a recording each
time a different channel becomes most prominent.
Configuration settings can be exported and imported.
A foot pedal can be used for playback.
A Sound Image window provides a graphical representation of the audio levels across an entire recording
file.
A file search facility lets you search for text across files.
Another file search facility lets you search for text or fields in files that have been processed by Liberty Web
Access. From the search results, you can open a file for playback or to make changes to it.
Integration with Windows Explorer allows you to display the details of docket/case fields without opening a
recording file.
Import bookmarks and file notes from BMR files created with Liberty Notes or Liberty Word-Notes.
A portable version of this program can be created which eliminates the need to install the program on a
user’s PC.

1.3

What's New in Version 2.0?
Version 2.0 of DCR Player is the first version of the software that replaces both the Digital Court Player and
Liberty Interview Player programs. As a result, there are a number of new features for prior users of these
programs as well as many enhancements due to the merger of the two programs.
If you were previously a user of either Digital Court Player or Liberty Interview Player, then all of the following
features are new:
You can choose to use speech enhancements, Automatic Gain Control (AGC) and/or noise suppression,
when exporting a file to formats other than DCR.
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All of the different types of export can be used when you open a file across an IP network using File->Open
URL.
Burn a media disc when exporting a recording file to MPEG-4 format.
When exporting a file to DCR format, all audio channels can be mixed to a single channel.
When exporting a file to PDF format, a logo image can be included at the beginning of the document.
A voice detection algorithm can be used to analyze an audio file you have open in the Sound Image Window
and highlight areas of speech. Also, on the Sound Image Window, you can choose to show or hide
bookmarks in the display. You access these settings via a new Settings button.
When using digital signatures, you can now use Time Stamp Authority (TSA) certification.
Enhancements to protect the program from dynamic changes to the audio output devices.
If you were previously a user of Digital Court Player, then all of the following features are new:
Ability to redact files so that redacted segments can be omitted from playback and when exporting. A
redacted segment can be played, skipped, or blacked out.
Export a dcr file to a video DVD in MPEG-2 format.
When exporting to WAV, DCR, AVI, WMV, or PDF format, additional files can be included.
Burn a media disc when exporting a recording file to PDF format.
Automatically close a file when there has been no activity for a specified number of minutes.
From the Video Playback window, you can pause the playback and save the screen image as a jpg, png or
bmp file.
When using the file search facility, the results can be sent to a folder, DVD, USB drive, etc.
A portable version of this program can be created which eliminates the need to install the program on a
user’s PC.
The “Docket Fields” configuration option has been renamed to “Docket/Case Fields”.
If you were previously a user of Liberty Interview Player, then all of the following features are new:
When exporting a file to PDF format, you can choose which audio channels are included as well as whether
file notes and notes in manual bookmarks are included.
Filter out ultra-low frequencies using the low-cut filter speech enhancement.
When printing bookmarks, you can choose to print all bookmarks or only those bookmarks that you have
selected.
The “Case Fields” configuration option has been renamed to “Docket/Case Fields”.
Note: The terms “docket” and “case” are used interchangeably.
To obtain more detailed information about the features of the DCR Player, review the “Features” section.

1.4

Version Information
Version 2.0

December, 2019

Version 2.0 of DCR Player is the first version of the software that replaces both the Digital Court Player and
Liberty Interview Player programs. As a result, there are a number of new features for prior users of these
programs as well as many enhancements due to the merger of the two programs.
If you were previously a user of either Digital Court Player or Liberty Interview Player, then all of the following
features are new:
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You can choose to use speech enhancements, Automatic Gain Control (AGC) and/or noise suppression,
when exporting a file to formats other than DCR.
All of the different types of export can be used when you open a file across an IP network using File->Open
URL.
Burn a media disc when exporting a recording file to MPEG-4 format.
When exporting a file to DCR format, all audio channels can be mixed to a single channel.
When exporting a file to PDF format, a logo image can be included at the beginning of the document.
A voice detection algorithm can be used to analyze an audio file you have open in the Sound Image Window
and highlight areas of speech. Also, on the Sound Image Window, you can choose to show or hide
bookmarks in the display. You access these settings via a new Settings button.
When using digital signatures, you can now use Time Stamp Authority (TSA) certification.
Enhancements to protect the program from dynamic changes to the audio output devices.
If you were previously a user of Digital Court Player, then all of the following features are new:
Ability to redact files so that redacted segments can be omitted from playback and when exporting. A
redacted segment can be played, skipped, or blacked out.
Export a dcr file to a video DVD in MPEG-2 format.
When exporting to WAV, DCR, AVI, WMV, or PDF format, additional files can be included.
Burn a media disc when exporting a recording file to PDF format.
Automatically close a file when there has been no activity for a specified number of minutes.
From the Video Playback window, you can pause the playback and save the screen image as a jpg, png or
bmp file.
When using the file search facility, the results can be sent to a folder, DVD, USB drive, etc.
A portable version of this program can be created which eliminates the need to install the program on a
user’s PC.
The “Docket Fields” configuration option has been renamed to “Docket/Case Fields”.
If you were previously a user of Liberty Interview Player, then all of the following features are new:
When exporting a file to PDF format, you can choose which audio channels are included as well as whether
file notes and notes in manual bookmarks are included.
Filter out ultra-low frequencies using the low-cut filter speech enhancement.
When printing bookmarks, you can choose to print all bookmarks or only those bookmarks that you have
selected.
The “Case Fields” configuration option has been renamed to “Docket/Case Fields”.
Note: The terms “docket” and “case” are used interchangeably.

1.5

Version Information for Digital Court Player
Version 7.8

March 21, 2019

A “Find in LWA” feature has been added that allows you to search for files processed by Liberty Web Access.
From the search results, you can open a file for playback or to make changes to it.
Digital certificates can be used to ensure recordings have not been altered.
When using a foot pedal, you can have a recording paused when the pedal is released. This keeps the
video window active.
The audio portion of your recording files can be played back in stereo.
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A Sound Image window provides a graphical representation of the audio levels across an entire recording
file.
When exporting a file to MP4 format, multiple independent video streams can be retained instead of being
merged into a single video stream.
Version 7.7

April 11, 2018

The following changes have been made to channel mixing modes:
A global hot key (CTRL+ALT+M) has been added so that you can toggle the channel mixing mode
between mixed mode and non-mixed mode without the need to bring the application into focus.
You can switch the mixing mode using a new button on the interface.
Global hot keys to select each channel have been restored as they were in earlier versions of Digital
Court Player.
Version 7.6

August 2, 2017

Export a dcr file to MP4 format. Using this export facility you can also create a portable version of a recording
file by choosing to create a separate meta-data file. In addition to the MP4 file, an html file will be created that
you can view through a browser of your choice. This allows you to play the video, listen to the audio, and use
bookmarks within the file.
Enhanced user interface items include the following:
A new Menu button provides access to menus in a vertical format.
You can choose to show or hide the menu bars.
An alternative way of customizing the various toolbars within the product is available. From each View
menu, you can choose to show or hide toolbar items.
Version 7.4

May 17, 2016

Further integration with Windows Explorer allows you to display the details of docket fields without opening a
recording file. Using Windows Explorer, you can hover your mouse over a file to display docket information,
click on a file to display docket information in the Detail panel, select which fields of a docket you want to
have displayed in the Windows Explorer interface, and display docket information using the Detail tab under
File - Properties.
A new audio processing algorithm called Channel Activity Detector (CAD) can be used to automatically insert
a bookmark into a recording each time a different channel becomes most prominent. These bookmarks can
be inserted by the Recorder program as a recording is taking place or they can be inserted by the Player
program during transcription playback.
The “Jump to Next Activity” feature can be used to find the next occurrence of a specified channel.
Version 7.3

December 15, 2015

Support for Windows 10.
When using the “Find in Files” search facility, you can display the details of the docket fields or file
information without opening each file and optionally copy all or some of this information to the Clipboard.
The “Find in Files” search facility has been updated to support Windows Search which is the successor to
the Indexing Service.
You can choose which bookmarks you want to print, copy to the Clipboard, or export.
Support for higher monitor resolutions.
A 64-bit version of the program is available.
Version 7.2

January 26, 2015
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Attach files, such as evidence documents, to a recording file.
Version 7.1

June 20, 2014

Ultra-low frequencies, less than 125 Hz, can be filtered out when playing back a recording. This is useful for
reducing the noise caused when someone bumps a microphone.
Version 7.0

April 2, 2014

A mirrored file containing sealed sections can now be opened in listen-only mode. There is the same
behavior of sealed sections as with the original (non-mirrored) file.
Digital Court Player can open a DCR file which is currently being mirrored if a link to this file is distributed
through Internet Information Services (IIS).
When using “Find in Files”, the results include columns for the duration of a recording and its end time.
The “Private Notes” column can be included in the list of bookmarks.
Certified by Microsoft as Windows 8 compliant.
When installing the program from the command line, a new switch lets you point to an exported
configuration file. This is useful when you are installing the program on multiple PCs and want to reuse
many of the same settings.
Version 6.5

October 9, 2012

Each time bookmarks are updated, a history of what was previously in the bookmarks is kept. This allows
you to display the bookmarks as of a particular date and time.
A DCR file can now be opened using the Windows drag-and-drop feature.
All docket fields can now be edited.
Support for fixed fields within File Notes.
The export function now uses Windows H.264 to encode video for export on Windows 7.
Support for DirectShow to decode video for export.
Minor UI enhancements.
Version 6.4

March 27, 2012

Playing recording files streamed over an IP network.
Improved synchronization of the audio / video media during playing.
More granular settings for the data which is included when exporting a file to PDF format.
Version 6.3

July 15, 2011

• Docket bookmarks can now be created from the Player.
• View, copy associated links, and clear trace files as required.
• Bookmarks can be printed in color.
• Bookmark titles from a recording file can be used instead of the titles defined in the Player’s configuration.
Version 6.2

May 27, 2010

Support for Windows 7.
Toolbar customization. For example, you can choose which buttons appear on a toolbar and the order in
which they appear.
Speed up access in listen-only mode when used with the NTFS file system.
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Bookmarks and file notes are now available in listen-only mode.
Replace text in file notes and bookmarks.
Version 6.0

August 12, 2009

You can open file attachments, delete attachments, seal/unseal attachments, and optionally include them
when exporting recording files.
Configuration options can be exported and imported. This allows you to set up multiple computers with the
same configuration.
The interface is now compliant with Section 508 of the Rehabilitation Act.
When exporting a file to WAV or AVI format, you can select the media format from a drop-down list of past
values.
When printing, the header and footer information is saved. You can also have the file name and print time
automatically inserted.
Version 5.2

March 7, 2009

Export a file, including bookmarks, audio, and video to PDF format. The media file can be created and saved
separately from the PDF document so that the audio/video links will work properly after you move the file onto
a Windows Media Server folder to be streamed to the end users.
Export a dcr file as a Windows Media file (wma, wmv).
A bookmark can be assigned a color, which allows you to highlight or classify bookmarks. For example, you
can use different colored bookmarks to differentiate child witnesses, sensitive information, etc.
Version 5.1

May 25, 2008

Support for Windows Vista.
The "Go to End" button has been added to allow a user to quickly go to the end of a recording.
A new utility is available within the Player to check the integrity of a DCR file.
When exporting a file to an audio CD, the Player burns the CD itself without the use of a system burning
wizard (Windows XP and Vista only).
Improvements in capturing and managing trace data.
You can open a file in listen-only mode, which allows you to listen to a file but prevents you from making any
updates.
Tooltips are now available in the Thin View.
Visual styles in Windows XP and Windows Vista are now supported, which allow you to change the visual
style of the user interface.
The font specified in your system properties is now applied to the Digital Court Player program.
The program is now packaged as an MSI file and uses the Windows Installer for installation.
Version 5.0

July 3, 2007

Export the audio data from a DCR file directly to an audio CD. Previously, you would need to convert the DCR
file into a WAV file and then use CD-burning software to write the data to a CD. To avoid creating a very large
file and to facilitate playback, you can have the file automatically split based on bookmarks or file size (in
minutes).
A desktop shortcut for this program can be automatically created during installation time.
Version 4.5

November 18, 2006
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A Plaintiff field has been added for dockets.
More granular settings for the data which is included when printing bookmarks, exporting bookmarks to a
text file, or copying bookmarks to the clipboard.
A Selection panel has been added to the main Digital Court Player window. On this panel, you can use a
slider and other controls to select part of a recording. This is particularly useful when you want to export only
part of a file.
Online playback allows you to play back a file as it is being mirrored.
Support for special characters and symbols in the fields used for bookmarks and dockets, and when using
such features as find in files and find in notes.
Ability to stop a search when searching files for text.
Version 4.4

July 12, 2006

Ability to change the bookmark columns that are displayed and the order in which they appear, and the
names of the docket bookmark fields.
Export sealed recordings with a password or to an unsealed format.
Customizable headers and footers can be used when printing.
Digital Court Player can be minimized to the Thin View.
Version 4.3

December 29, 2005

Sound quality improvements using Automatic Gain Control (AGC).
A file search facility lets you search for text, times, and dates across files.
An audio tone can be issued when the playback of a recording is stopped or paused.
2-character channel names can be displayed in place of the channel numbers.
Both absolute and relative times can be displayed in the Thin View.
When exporting a segment of a file, you can select the segment based on absolute times.
Bookmarks now contain a Speaker field.
Ability to set the font used in bookmarks and notes.
Show/hide different fields in the Bookmarks window.
Automatically step-back a specified number of seconds when releasing your foot pedal during fast-forward
operations.
Support for read-only files. Users can open and play read-only files but are unable to edit them.
Ability to disassociate DCR files with this program.
Version 4.2

August 08, 2005

Suppress the level of noise and adjust the tone when playing files.
Export captured video as an AVI file.
Optionally, include video data and file notes when exporting a file.
Ability to open files from the Thin View.
Rewind files using a foot control.
Printing options for bookmarks and file notes allow you to add a title, change the font, print page numbers,
and preview the printed output.
Optionally, have the File Notes window automatically displayed when opening files.
Digital Court Player is installed as a common application where options can be set for each user or shared
amongst multiple users of the same computer.
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Version 4.1

June 11, 2005

Introduced additional user controls for devices that do not support the standard Windows mixer.
Version 4.0

May 3, 2005

Internal release only.
Version 3.0

April 15, 2005

Video playback.
Ability to adjust the levels of individual channels.
Export a selected area of a file instead of the entire file.
Ability to search for text within file notes.
Export file notes to a text file.
File notes and bookmarks can be copied to the clipboard or printed.
Tailor the display of bookmark information by showing/hiding different fields.
Version 2.0

November 16, 2004

Export to a WAV or DCR file with any combination of channels.
Export bookmarks or parts of bookmarks to a text file.
Import bookmarks and file notes from BMR files created with Liberty Notes or Liberty Word-Notes.
Search capability for text within bookmarks.
Indicators for active channels.
Private notes can be used in bookmarks, and optionally excluded when exporting a bookmark to a text file.
Jump-to-time feature during playback allows easy navigation within a file.
Retain last position in a file when it is closed and restore it when loading.
Preserve tone automatically during high-speed playback.
Version 1.2

July 14, 2004

Ability to play any combination of channels.
Version 1.1

March 17, 2004

The version was released.

1.6

Version Information for Liberty Interview Player
Version 3.2

March 18, 2019

After searching for files processed by Liberty Web Access, you can open a found file for playback or to make
changes to it.
The audio portion of your recording files can be played back in stereo.
A Sound Image window provides a graphical representation of the audio levels across an entire recording
file.
When exporting a file to MP4 format, multiple independent video streams can be retained instead of being
merged into a single video stream.
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September 11, 2018

A “Find in LWA” feature has been added that allows you to search for files processed by Liberty Web Access.
When using a foot pedal, you can have a recording paused when the pedal is released. This keeps the
video window active.
Include additional files when exporting a dcr file to a hard disk when using either the Export or Export to
Adobe PDF options.
Export a dcr file to MP4 format. Using this export facility you can also create a portable version of a recording
file by choosing to create a separate meta-data file. In addition to the MP4 file, an html file will be created that
you can view through a browser of your choice. This allows you to play the video, listen to the audio, and use
bookmarks within the file.
The following changes have been made to channel mixing modes:
A global hot key (CTRL+ALT+M) has been added so that you can toggle the channel mixing mode between
mixed mode and non-mixed mode without the need to bring the application into focus.
You can switch the mixing mode using a new button on the interface.
Global hot keys to select each channel have been restored as they were in earlier versions of DCR Player.
Version 3.0

December 1, 2016

Further integration with Windows Explorer allows you to display the details of case information bookmarks
without opening a recording file. Using Windows Explorer, you can hover your mouse over a file to display
case information, click on a file to display case information in the Detail panel, select which fields of a case
you want to have displayed in the Windows Explorer interface, and display case information using the Detail
tab under File - Properties.
The “Find in Files” search facility has been updated to support Windows Search which is the successor to
the Indexing Service.
Enhanced user interface items include the following:
A new Menu button provides access to menus in a vertical format.
You can choose to show or hide the menu bars.
An alternative way of customizing the various toolbars within the product is available. From each View
menu, you can choose to show or hide toolbar items.
Support for Windows 10.
Support for higher monitor resolutions.
A 64-bit version of the program is available.
Version 2.8

June 30, 2015

Attach files, such as evidence documents, to a recording file.
The configuration of Case Fields has been enhanced. You can specify the number of fields that will be
available in case-style bookmarks, define different types of fields (i.e. standard, date, fixed list, or text), and
enable users to choose from a drop-down list of possible values.
To support the use of different programs and systems, you can export and import case field settings.
When using the “Find in Files” search facility:
You can display the details of the case fields or file information without opening each file and optionally copy
all or some of this information to the Clipboard.
One or more of the resulting files from a search can be sent to a folder, DVD, USB drive, etc.
The results include columns for the duration of the recording and its end time.
Distorting the video in a redacted segment of a recording file includes the following new features:
The use of a face detection algorithm that automatically detects a face in a frame.
Automatic face tracking can dynamically change the area of video being distorted.
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Using your mouse, you can use manual face tracking to change the area being distorted.
Different intervals within a redacted segment can have different distortion modes. For example, one interval
can have the entire frame distorted while another interval can use automatic face tracking.
You can edit the intervals of distortion and preview the results of the distortion.
Support for higher resolutions of video.
Memory consumption improvements.
Version 2.7

October 13, 2013

From the Video Playback window, you can pause the playback and save the screen image as a jpg, png or
bmp file.
A mask value of "z" has been added to represent either a character or a digit when enforcing a standard for
the case number or the officer name in case fields.
When installing the program from the command line, a new switch lets you point to an exported
configuration file. This is useful when you are installing the program on multiple PCs and want to reuse
many of the same settings.
The start time, end time, and date of an interview can be printed on a LightScribe label.
Ability to set the font size used on a LightScribe label.
Certified by Microsoft as Windows 8 compliant.
Minor UI and usability enhancements.
Version 2.6

January 11, 2013

A DCR file can now be opened using the Windows drag-and-drop feature.
All case fields can now be edited.
Support for fixed fields within File Notes.
Support for the LightScribe technology that allows case information to be printed directly onto disc labels.
Audio distortion for redacted segments such that either the audio is muted or it is distorted via a voice
encoder so that the audio can be understood but the person’s voice cannot be recognized.
The Export functions were refined regarding distorted media. The exporting of distorted segments depends
upon your redaction settings.
You can standardize the format of the Officer case field.
Minor UI enhancements.
Version 2.5

June 28, 2012

Recording files can be streamed over an IP network.
Video can be distorted so that the person being recorded cannot be visually recognized.
Improved synchronization of the audio and video media during playback.
Comments can be saved in redaction bookmarks.
A timeout value can be specified such that the Player will time out after a period of inactivity and free up the
file it has open.
Each time bookmarks are updated, a history of what was previously in the bookmarks is kept. This allows
you to display the bookmarks as of a particular date and time.
You can standardize the format of the Case Number.
When specifying the Incident Date for a case, a calendar can be used to ensure all dates use the same
format.
Version 2.4

July 15, 2011
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You can choose not to keep a history of the values you use in the different types of case fields so that these
values will not appear in drop-down lists.
A media disc can be burned for any type of supported export operation.
A new type of exported or burned file ensures a complete copy of a DCR file, including notes, bookmarks,
attachments, etc.
For redacted segments during playback, you can choose whether to play them, jump over them, or overlay
them with blank data.
When exporting a recording file, you can choose to include or exclude all of the redacted segments or some
of the redacted segments.
Version 2.3

March 16, 2011

A portable version of this program can be created which eliminates the need to install the program on a
user’s PC.
Bookmarks can be printed in color.
Case fields from a recording file can be used instead of the fields defined in the Player’s configuration.
Version 2.2

October 29, 2010

Digital certificates can be used to ensure recordings have not been altered.
Case-style bookmarks can now be created from the Player.
The process to export recording files to DVD has been enhanced. The dependency on DVD Maker has been
removed.
Import bookmarks and file notes from BMR files created with Liberty Notes and Liberty Word-Notes.
View, copy associated links, and clear trace files as required.
Version 2.1

May 19, 2010

Support for Windows 7.
Ability to redact files so that redacted segments can be omitted from playback and when exporting.
Export a .dcr file to DVD-video format.
Toolbar customization. For example, you can choose which buttons appear on a toolbar and the order in
which they appear.
Speed up access in listen-only mode when used with the NTFS file system.
Bookmarks and file notes are now available in listen-only mode.
Replace text in file notes and bookmarks.
Version 2.0

October 16, 2009

Case-style bookmarks can be used to identify case-related information.
A bookmark can be assigned a color, which allows you to highlight or classify bookmarks. For example, you
can use different colored bookmarks to differentiate sensitive information.
You can open file attachments, delete attachments, and optionally include them when exporting recording
files.
Configuration options can be exported and imported. This allows you to set up multiple computers with the
same configuration.
The interface is now compliant with Section 508 of the Rehabilitation Act.
Export a .dcr file as a Windows Media file (wma, wmv).
When exporting a file to WAV or AVI format, you can select the media format from a drop-down list of past
values.
When printing, the header and footer information is saved. You can also have the file name and print time
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automatically inserted.
Version 1.1

October 10, 2008

When you export a file to PDF, the media file can be created and saved separately from the PDF document.
This allows the audio/video links to work properly after you move the file onto a Windows Media Server folder
to be streamed to the end users.
Version 1.0

July 25, 2008

The version was released.

1.7

Components and Requirements
The DCR Player is a component of the Digital Recording Solution.
The minimum computer requirements for using the DCR Player are:
A standard PC or laptop with the Windows Vista operating system or later.
A standard Windows-compatible mono sound card with headphones or speakers that will be used for audio
playback.
Optionally, playback can be controlled using a VEC Infinity USB foot-pedal. You can obtain this pedal from a
third party vendor or from BIS Digital and associated Digital dealers.
Contact BIS Digital Inc. for further assistance.

1.8

Trademarks and Copyright Rights
Other product and company names appearing in BIS Digital Inc. products and materials are used for
identification purposes only and may be trademarks or registered trademarks of their respective companies.
Registered and unregistered trademarks used in any BIS Digital Inc. products and materials are the exclusive
property of their respective owners.

Speex License
Support for Speex format is based on the source code of the Speex codec. Using this code requires that the
following information be included with any copy or redistribution of its code.
Copyright 2002-2008 Xiph.org Foundation
Copyright 2002-2008 Jean-Marc Valin
Copyright 2005-2007 Analog Devices Inc.
Copyright 2005-2008 Commonwealth Scientific and Industrial Research Organisation (CSIRO)
Copyright 1993, 2002, 2006 David Rowe
Copyright 2003 EpicGames
Copyright 1992-1994 Jutta Degener, Carsten Bormann
Copyright (C) 2003 Edmunt Pienkowsky
Copyright (C) 2003 Christian Buchner
Redistrib ution and use in source and b inary forms, with or without modification, are permitted provided that the
following conditions are met:
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• Redistrib utions of source code must retain the ab ove copyright notice, this list of conditions and the following
disclaimer.
• Redistrib utions in b inary form must reproduce the ab ove copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distrib ution.
• Neither the name of the Xiph.org Foundation nor the names of its contrib utors may b e used to endorse or
promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Simd License
Using the source code of the Simd library requires that the following information be included with any copy or
redistribution of its code.
Copyright (c) 2011-2014 Yermalayeu Ihar.
Permission is hereb y granted, free of charge, to any person ob taining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, pub lish, distrib ute, sub license, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, sub ject to the following conditions:
The ab ove copyright notice and this permission notice shall b e included in all copies or sub stantial portions of
the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NON INFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

1.9

Installing the DCR Player
DCR Player is installed as a common application. It supports an "All Users" install to allow different users to
work with the program on the same computer.
The DCR Player program is packaged as an MSI file and uses the Windows Installer for installation. To install
the program, take the following steps:
1. Run DcrPlay20.msi (32-bit version) or DcrPlay20-x64.msi (64-bit version).
2. Follow the instructions on the screen.
A 64-bit version of the program is available; however, it cannot be installed over the 32-bit version. If you have a
32-bit version installed and want to use the 64-bit version then you should do the following:
1. Export the configuration options being used with your current 32-bit version of the program.
2. Uninstall the 32-bit version.
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3. Install the 64-bit version of the program as described below.
4. Import your exported configuration options from your old version to your new version.
For more information, refer to “Exporting and Importing Configuration Options”.
When installing the program from the command line, you can use the IMPORT_OPT (non-case-sensitive)
switch to point to a configuration file. This is useful when you are installing the program on multiple PCs and
want to reuse many of the same settings. You can install the program on one PC, customize its settings, export
the settings to a .cfg file, use the IMPORT_OPT switch to point to the .cfg file when installing the program on
another PC, and then perform any further customization unique to the program running on that PC.
Examples
The following specifies the location of a .cfg file:
DcrPlay20.msi IMPORT_OPT=c:\work\Options_LCP.cfg
If the .cfg file is located in the same directory as the MSI file, you do not need to specify the directory again as
part of the IMPORT_OPT switch, as shown below:
DcrPlay20.msi IMPORT_OPT=Options_LCP.cfg
If the path or file name contains spaces then the string must be surrounded by quotation marks, as shown
below:
DcrPlay20.msi IMPORT_OPT="Options LCP.cfg"
Once you have installed DCR Player on a PC, you can create a portable version of the program. This is useful
when users are restricted from installing software on their PCs as they can use the program without installing
any software. See also “Using the Portable Version of DCR Player”.

1.10

Uninstalling the DCR Player
To uninstall DCR Player, from the Windows Start menu, choose “Programs” - “DCR Player” - “Program
Maintenance”. On the Program Maintenance window, select "Remove".
Alternatively, use “Start - Settings - Control Panel - Add/Remove Programs”.

2

Configuring DCR Player

2.1

Configuring DCR Player
To configure the DCR Player, you use the Options dialog to set configuration options.
Note that you can export and import configuration options when setting up similar systems.
To set configuration options:
From the main DCR Player window, click the
button, or from the View menu, click Options. A dialog
appears from which you can access different configuration options. You can select from the following:

Configuring DCR Player

Dialog

Use this dialog to set options for

Playback

Playback devices, behavior for automatic and manual pauses, notification when
recording is stopped

Speed

Altering playback speeds

StartUp

Starting DCR Player

Hot Keys

Setting hot keys

Foot Control

Using a foot control to control playback

General

Default folders, displaying different windows, minimizing the DCR Player
application, opening files, signature verification, temporary files, closing a file due to
inactivity, file association

Security

Enabling the playback of sealed sections of a recording

Docket/Case Fields

Specifying which docket/case fields to use, the titles of the fields, and their default
values

Redaction

Redacted segments

Video DVD (MPEG-2)

Burning files to DVD in MPEG-2 format

You can use the following buttons:

Button

Function

OK

Save your changes and exit the configuration dialogs.

Cancel

Cancel all of your changes that have not been saved.

Apply

Save your changes and keep the current dialog open.
Restore the default settings for the current dialog.

Each of the configuration options is described in detail in the following sections.

2.2
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Using the Playback Dialog
Use the Playback dialog to set options for playing files.
When you select Playback, the following dialog appears.
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Wave device
Select your audio device (sound card) for playing. If the setting is “system default”, then DCR Player uses the
device specified in your system audio settings (e.g. Start - Settings - Control Panel - Multimedia - Audio).
Playback with automatic pauses
DCR Player provides an automatic-pause mode for more effective transcription. When enabled, this feature
plays a recording, pauses the playback, and then resumes the playback. This play/pause/play cycle continues
for the duration of the file playback. You can use this feature to automatically pause the playback at certain
intervals to allow you to catch up in transcribing. In some cases, this can eliminate the need for a foot pedal or
the use of hot keys to control playback.
Duration of continuous playback - Specify the duration of continuous playback, in seconds.
Size of automatic pause - Specify the size of the pause, in seconds.
Size of step back after automatic pause - Specify the size of the step back, in seconds.
For example, if you set “Duration of continuous playback” to 15 seconds, “Size of pause” to 5 seconds, and
“Size of step back after pause” to 3 seconds, then a file plays for 15 seconds, pauses for 5 seconds, and then
goes back 3 seconds and starts playing from there.
Automatically step back after manual pause
This feature automatically rewinds the recording a specified number of seconds whenever you pause
playback. This applies when using a foot pedal or when using the Pause button on DCR Player’s primary
window.
Use step back - Check this box if you want to use a step back after a manual pause.
Size of step - Specify the size of the step back, in seconds.
Retain last position
Select this option to retain the last position of the file being played when it is closed. When you start to play the
file again, playback starts from where it left off.
Notification when recording is stopped
You can be notified via an audible tone when playback is paused or stopped. This alerts you that the playback
of a recording was turned off. This is useful when the auto-bookmarks are not visible, such as when using the
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Thin View or when DCR Player is minimized.
To generate a simple tone when playback is stopped or paused, take the following steps:
1. Press the "Notification when recording is stopped..." button. The following dialog appears:

2. Select “Generate a simple tone during playback”. You can adjust the frequency and duration of the tone. The
volume depends on your current system settings. To select tone parameters, click on the
button. Note:
This method will not work if you are playing sound through your sound card and your card does not allow the
mixing of sounds.
Use the Advanced button to display the “Advanced Playback Settings”. The dialog looks like this:

Sound processing for playing all channels
Default settings are normally acceptable. Only change these settings under the advice of Technical Support.
Speech Enhancements - Use Voice Activity Detector (VAD) for AGC
This check box activates/deactivates the noise suppression amplification algorithm called Voice Activity
Detector (VAD). When this function is active, the AGC algorithm reacts only to fragments that contain voice. This
makes the algorithm’s performance more accurate when processing voice recordings, and it prevents the
program from raising the noise level during long pauses.

2.3

Using the Speed Dialog
Use the Speed dialog to set options for playback speeds. You can increase the playback speed beyond its
normal speed and you can reduce the playback speed below its normal speed. Playback speeds are
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controlled through the Increase and Decrease Playback Speed buttons on the main DCR Player window. Note
that these buttons are only visible during playback. The amount by which the speed increases or decreases is
controlled by the settings you specify on the Speed dialog.
When you select Speed, the following dialog appears.

Preserve tone automatically during high-speed playback
When this option is selected, DCR Player tries to preserve tones when playing back a recording at a higher
than normal speed.
Retain altered playback speed
Check this box if you want to keep this altered speed setting. Otherwise, the speed value for each new
playback is reset to the normal speed (i.e. x1). For more information, refer to “Playback with Different Speeds”
later in this document.
Step for altering playback speeds, when they are beyond the normal playback speed
This step is used to alter playback speeds in a range from 1-times to 2-times the normal speed. When the
playback speed is above normal, this step is used when you increase or decrease speed.
For example, if the playback speed is set at normal and this step is set to .3, then the first time you press the
Increase Playback Speed button, the playback speed increases to 1.3 times the normal speed. The next time
you press the Increase Playback Speed button, the playback speed increases to 1.6 times the normal speed,
and so on. If you press the Decrease Playback Speed button while the speed is greater than normal, then the
speed decreases by .3 times the normal speed.
Step for altering playback speeds, when they are less than the normal playback speed
This step is used to alter playback speeds in a range from .5-times to 1-times the normal speed. When the
playback speed is below normal, this step is used when you increase or decrease speed.
For example, if the playback speed is set at normal and this step is set to .2, then the first time you press the
“Decrease Playback Speed” button, the playback speed decreases to .8 times the normal speed. The next time
you press the “Decrease Playback Speed” button, the playback speed decreases to .6 times the normal
speed, and so on. If you press the “Increase Playback Speed” button while the speed is less than normal, then
the speed increases by .2 times the normal speed.

2.4

Using the StartUp Dialog
Use the StartUp dialog to set options for the start of the DCR Player application.
When you select Startup, the following dialog appears.
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Minimize when program starts
Check this box to minimize the main window after the application starts. The behavior when you minimize is
based on the minimize method (Options - Minimize).
Load a file when program starts
You can optionally select a file to be automatically loaded when DCR Player starts. Choose one of the
following:
Load last-used file - load the file DCR Player last played.
Load this file - locate the specific file to be loaded.
If the file no longer exists, or has been moved, this has no effect.
Action
Select “Start playback” if you want to automatically start playback of the file specified above after the application
starts.

2.5

Using the Hot Keys Dialog
Use the Hot Keys dialog to set hot keys for quick access to common commands.
When you select Hot Keys, the following dialog appears.
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Enable Hot Keys
Check this box if you want to use global hot keys.
Setting Hot Keys
To change a hot key setting, take the following steps:
1. Click on the item in the list of commands that you want to change.
2. In the “Press new key” box, press the keyboard combination you want to use as a hot key.
3. Click OK or Apply.
You can use “Clear” to disable a hot key or “Clear all” to set all hot keys to “None”.
If any of these combinations is used by another active application or shortcut, the combination will not work
with DCR Player.

2.6

Using the Foot Control Dialog
Use the Foot Control dialog to set options for using a foot control to control playback.
When you select Foot Control, the following dialog appears.
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Enable Foot Control
Check this box if you want to use a foot control.
Device
Select your foot-pedal device from the drop-down list.
Number of pedals
Select the number of foot pedals. You can use a 2 or 3-pedal device.
Set pedal functions
Use this button to display the “Pedal Functions” dialog. This dialog lets you assign functions for each device
pedal and enables you to control the playback of sound data.
Foot Control Wizard
In order for the foot control to work properly, you should define a mapping of events. For example, you can
automatically step forward a specified number of seconds when you press the left pedal. You use the Foot
Control Wizard to map events.
For more information on using foot controls, refer to “Using a Foot Control”.

2.7

Using the General Dialog
Use the General dialog to set options for default folders, displaying different windows, minimizing the DCR
Player application, opening files, signature verification, temporary files, closing a file due to inactivity, and file
association.
When you select General, the following dialog appears.
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Default folder
Set a default folder for opening and saving a file. DCR Player can use the previously used folder as the default
(select “Last used folder”) or you can specify the default folder yourself (select “This folder” and specify the
location).
If you type in the name of a new folder then DCR Player automatically creates this folder when you click on the
OK or Apply button.
Minimize to
Choose the behavior when you minimize the DCR Player application. Select one of the following:
Task Bar - appears minimized in the Task Bar. This is the normal behavior.
System Tray - appears as an icon in the System Tray.
Thin View - display DCR Player's Thin View. For more information, see "Using the Thin View".
Automatically show
Choose the windows you want to have displayed automatically.
File notes window - select this box if you want to have the File Notes window automatically displayed when
opening a file that contains file notes.
Bookmarks window - select this box if you want to have the Bookmarks window automatically displayed when
opening a file that contains bookmarks.
Video window - select this box if you want to have the Video window automatically displayed when opening a
file that contains video.
Always open file in listen-only mode
Select this check box if you want to always open files in listen-only mode. This allows you to listen to a file and
display file notes and bookmarks but prevents you from making any updates. This is useful for administrators
who won't be updating files, and it prevents the file from being locked.
Note: Listen-only mode only works properly in an NTFS environment.
Verify signature after opening a file
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Select this box if you want to check when opening a file that it has not been altered after it was recorded. Select
“Suppress message if verification is successful” if you do not want a message displayed when the verification
is successful.
Close the file when there is no activity for … minutes
Select this check box if you want DCR Player to close the file it has open after a specified period of inactivity so
that the file is available to other users. Specify the number of minutes of inactivity to trigger this process in the
box to the right.
Use the Advanced button to display the “Advanced General Settings”. The dialog looks like this:

Folder for temporary files
If required, you can specify a folder for temporary files. The size of a recording file can be quite large. Because
of this, the DCR Player application saves recorded information in a temporary file rather than in memory.
Associate program with DCR files
Click this button if you want to manually associate DCR files with DCR Player. Refer to “Associating DCR Files
with a Digital Program” for more information.

2.8

Using the Security Dialog
Use the Security dialog to enable you to playback sealed sections of a recording (only for recording files
created in Digitaly Court Recorder).
When you select Security, the following dialog appears.

Enable security
Select this option if you want to playback sealed sections of a recording. You can disable security by simply
clearing the Enable security check box.
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If you want to specify a password, click the Change password button. The Specify Password dialog box
appears:

Specify Password
Complete the following fields:
New Recording password - password that is being used by Digital Recorder to seal data.
Confirm new Recording password - re-enter the recording password.
Once you specify the Recording password, then you can use DCR Player to play sealed sections of a recording
that were recorded using this same password.
If you do not specify a password and security is enabled, then you will be prompted when you try to open a
sealed recording to either supply the correct password or skip the sealed segments.
See also "Working with Sealed Recordings".

2.9

Using the Docket/Case Fields Dialog
Use the Docket/Case Fields dialog to select which docket/case fields to use, customize the titles, and specify
default values for these fields. These fields affect what appears when using the file search facility.
When you select Docket/Case Fields, the following dialog appears.

Number of fields

Configuring DCR Player

29

Select the number of fields you want to use for dockets/cases. The default is 5. The maximum number is 10.
Settings for Docket/Case Fields
Click this button to specify your field settings. The following dialog appears:

Title - You can replace a default title by typing the new title in the corresponding text field in this column.
Field Type - The following types of fields are supported:
Text - a text-based field where the user can enter data in any format.
Fixed List - a list of possible values will be presented to the user via a drop-down list. You will need to
configure the list of values by clicking the Settings button and adding the possible values.
Standard - the user must enter data in a standardized format as identified in the “Type Settings” column.
Date - the user will select the date from a calendar when creating new dockets/cases.
Type Settings - use this column to specify the format for standardized fields or to specify the list of possible
values for fixed list fields.
Default Value - specifies the default value for the field.
Required Field - select this check box to indicate the field is required when creating a docket/case.
Keep History - select this check box if you want to keep history for a field other than a Fixed List field. This
allows you to select a previously used value for a field from a drop-down list.
Default value for Notes field - You can specify a default value for the Notes field to be used when creating a
new docket/case.
Using Standardized Formats
A standardized format can consist of the following elements:
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a - matches any letter
n - matches any digit
z - matches any letter or digit
an upper-case character - matches only itself
a special character - matches only itself
a blank - matches only a blank.
Examples of Standardized Docket?Case Numbers

Format

Valid Docket/Case No.

nn-nnnnn

12-34567

ABC nnn

ABC 293

aaa-YRP-nn-nnn

BRE-YRP-01-042

aaa-QAE-nnn-zzz

ASD-QAE-013-M48

In any segment of two or more digits, leading zeroes will be added when necessary to pad the field to the
correct number of digits. For example, if the standard format is nnnn-nnnnnn and you type 43-156 as the
docket/case number, then this will be automatically changed to 0043-000156.
Exporting and Importing Field Settings
You can export your current field settings to a configuration file in XML format. This file can then be imported on
another system or by another program. From DCR Player, you can import field settings either from a
configuration file or from an open recording file.
Note: You can also export and import all configuration options. Refer to “Exporting and Importing Configuration
Options”.

2.10

Using the Redaction Dialog
Use the Redaction dialog to specify the default playback behavior for a new redacted segment.
When you select Redaction, the following dialog appears.
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Choose one of the following actions for playback of a new redacted segment:
Play the redacted segment
Skip the redacted segment
Black out the redacted segment
This sets the default behavior. You can override this behavior when you create a new redacted segment.
Use the Advanced button to display the “Advanced Redaction Settings”. The dialog looks like this:

You can adjust the settings related to audio distortion using a voice encoder:
Select the type of noise, the pitch, and the bands. The bands range from 8 to 64 with a default of 24. The higher
the value of the band, the more understandable the speech.
See also "Using Redaction" and "Distorting Video in Redacted Segments".

2.11

Using the Video DVD (MPEG-2) Dialog
Use the Video DVD MPEG-2 dialog to enable burning of recorded files to DVD in MPEG-2 format and to specify
the location of the DVD-burning engine.
When you select Video DVD MPEG-2, the following dialog appears.

Enable exporting to Video DVD (MPEG-2) - select this option to allow burning to DVD in MPEG-2 format. An
MPEG-2 DVD can be played on a home entertainment system.
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Folder containing video DVD-burning engine - specifies the location of the DVD burning engine. Contact BIS
Digital or your local Digital dealer to obtain the open source DVD engine software and unzip the package into
the folder you specify here.
Use the Advanced button to display the “Advanced Video DVD Settings”. The dialog looks like this:

You can specify properties such as quality, format, aspect ratio, and font size.

2.12

Exporting and Importing Configuration Options
You may want to set up DCR Player on similar systems with the same configuration options. From one
system, you can export the configuration options as a file and then import that file to another system.
To export all of your configuration options for DCR Player, take the following steps:
1. From the main window, click Tools, and then Export Configuration Options.
2. Specify the name and location for the exported file.
To import configuration options to DCR Player, take the following steps:
1. If you have a recording file open, you will need to close it.
2. From the main window, click Tools, and then Import Configuration Options.
3. Specify the name and location for the file containing the configuration options you want to import.
4. Once the file has been imported successfully, you must restart DCR Player to continue to use it.
You can also import configuration settings at installation time. Refer to “Installing the DCR Player”.
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The DCR Player main window consists of different parts, as shown below:

DCR Player Menus
From the main DCR Player window, you can use the following menus:

Menu

Use this menu to …

File

Open/close a file, start/finish LWA editing, open a URL, export data, sign or verify a signature,
display file properties, exit the program.

Playback

Play, pause, stop, adjust the playing speed, set the channels being played, start/stop playback
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in stereo, set stereo parameters, switch channel-mixing mode, use automatic pauses, jump to
a time, jump to the next occurrence of a specified channel.
View

Show/hide different options (i.e. menu bar, toolbar, toolbar items, recording levels, Bookmarks
window, Sound Image window, etc.), customize the font, switch the type of view, customize the
toolbars, set configuration options.

Tools

Insert special symbols, activate/deactivate speech enhancements, use the Channel Activity
Detector, find text in files, search for information in files processed by LWA, export/import
configuration settings, create a portable version of the player.

Selection

Select part of a recording.

Help

Display online help, activate the trace facility, analyze a DCR file, display program information.

You can access each menu either from the menu bar or by clicking the Menu button.
Note: If the menu bar is not visible, press the Alt key.
Main Toolbar
The toolbar allows you easy access to common operations. On the default toolbar, you can use the following
buttons, and associated menu items and shortcut keys:

Button

Description

Menu

Shortcut Key

Open an existing DCR file.

File - Open

Ctrl + O

Export to WMV, WAV, AVI or DCR file.

File - Export

Ctrl + Shift + E

Playback with automatic pauses.

Playback - Automatic Pauses

Ctrl + Q

Jump to time position in recording.

Playback - Jump to time

Change configuration options.

View - Options

Show or hide the File Notes window.

View - File Notes

Show or hide the Bookmarks window.

View - Bookmarks

Show or hide the Video window.

View - Video Window

Show different video sources

View - Video Window with ...

Switch to the Thin View.

View - Thin View

Find data in files

Tools - Find in Files

Alt + F7

Alt + F2

Alt + F5

Display menus

Status
Displays status, length of file, absolute date and time, and time positions relative to the start and end of the file.
Both the current position in a sound file (in seconds) and the time remaining in the file (in seconds) are
displayed. When DCR Player can determine the time value for the current position, this time value is displayed
in the “Time” field.
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You can select “File - Properties” for more information about the current file.

Slider (below Position)
Displays the current position in a sound file. You can move the slider back and forth.
Selection Panel
Allows you to select a part of a recording file. For more information, see "Using the Selection Panel".
Playing channels
Controls which channels are being played. You can switch between the different channel selections using your
mouse, a hot key, or your foot pedal. Use Ctrl+Click or Shift+Click to select more than one channel. If you are
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using more than eight channels, you can use the arrows to the right to scroll.
The

button to the right indicates whether any combination of channels can be mixed during playback.

When the button looks like
, mixed mode is switched off. This means the program can play only one
channel at a time or all channels together.
When the button looks like
, mixed mode is switched on. This means the program can play any
combination of channels you choose.
Volume
You can use the volume slider to control the playback volume. The indicator to the left indicates the sound level.
You can use the following buttons, menus and shortcuts:

Button

Description

Menu

Shortcut Key

Play

Playback - Play

Ctrl + P

Pause/continue

Playback - Pause

Ctrl + U

Stop

Playback - Stop

Ctrl + T

Rewind to the beginning

Playback - Go To - Home

Ctrl + H

Left (one step)

Playback - Go To - Left

Ctrl + F

Right (one step)

Playback - Go To - Right

Ctrl + G

Go to end

Playback - Go To - End

Ctrl + E

After the
and
recording.

buttons is a list where you can select the step these buttons use when positioning your

Customizing the Toolbar
You can customize the different toolbars used in DCR Player.
There are two ways to customize the toolbars.
From the View menu on the main window, you can click Customize Toolbars to customize each of the
toolbars within the product. After you select a toolbar, you can choose which buttons appear on each toolbar,
the order in which they appear, and other characteristics.
From each View menu, you can click Show/Hide Toolbar Items to choose which items appear on the toolbar
for that particular window. For example, on the Bookmarks window, you can choose which items appear on
the Bookmarks toolbar.
Using View - Customize Toolbars
On the main window, from the View menu, click Customize Toolbar. The following dialog box appears.
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To show/hide the toolbar, select/clear the Visible check box.
To lock the toolbar to prevent it from being repositioned, select Lock.
If you want the toolbar to include a Menu button for alternative access to each menu item, select Menu button.
To add a toolbar button, select a button from the list of Available toolbar buttons, and then click Add.
Alternatively, you can drag-and-drop a button from one list to the other.
To remove a toolbar button, select a button from the list of Current toolbar buttons, and then click Remove.
Alternatively, you can drag-and-drop a button from one list to the other.
To change the position of buttons on the toolbar, select a button from the list of Current toolbar buttons, and
then click Move Up or Move Down.
To restore the toolbar buttons to their default settings, click Restore default.
ou can also customize the toolbar by right-clicking the toolbar, and then clicking Customize.
Using View - Show/Hide Toolbar Items
On the View menu for a particular window, click Show/Hide Toolbar Items. A list of the possible toolbar items
for that window appears. Select the items you want to appear on the toolbar.
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3.2

Playback

3.2.1

Playing a Sound File
Before you Begin Playing
Set your playing device and other parameters, if they have not been set. Select “View - Options” and select the “
Playback” dialog.
If you want to view video during playback, select "View - Video Window", or press the
button on the main
toolbar. The Video window appears. The window remains black until there is some video to display.
Different ways you can open a sound file include the following:
From the File menu, click Open.
Drag the file from another program, such as Windows Explorer, into DCR Player’s main window.
Copy (Ctrl+C) the file from Windows Explorer and paste (Ctrl+V) it into DCR Player’s main window.
Starting the Playback
To play a sound file, open the file to be played, and then click on the
button or select “Playback - Play”. The
application starts playing the file either from the current position or from the beginning if the current position is
set to the end of the file.
Viewing Video During Playback
If a sound file contains video, you can select "View - Video Window" to display the recorded video in a separate
window. Since video can be captured from up to 8 sources, you can use the "View - Video Window display" to
select which video sources to display. The status bar shows the current frame size and the size of the video
area. From the View menu, you can show/hide the status bar, adjust the quality of the video, zoom in and out,
and adjust the video size to fit in the window.
When the playback is paused, you can capture the image on the video display and save it as a .jpg, .png, or .
bmp file. From the File menu, select Create Picture. Specify the name of the file and its type. Optionally, you
can use a prefix for saved file names.
Handling of Redacted Segments
If the file contains redacted segments, by default, an individual setting determines whether a segment is
played, skipped over, or blacked out. During playback of a file, you can choose to override this default behavior
and play all redacted segments, skip them all, or black them all out. From the “Bookmarks window”, select “
Redaction - Playback” and then choose one of the menu items.
Pausing the Playback
To interrupt the playing of a sound file, click on the
paused playback, click on the

button or select “Playback - Pause”. To resume a

button or select “Playback - Pause”.

Moving Within a File
To move forward or backward in a sound file, you can use the slider or the
or left with a fixed step using the

and

buttons. You can also move right

buttons, or by using the corresponding menu items or shortcuts.

Changing the Speed of Playback
You can change speed of playback. It can be useful for fast searches or for more effective transcription. For
more information about changing the speed, refer to “Playback with Different Speeds”.
Step Back after Manual Pause
You can use a step back after a manual pause. This is equivalent to the operations: Stop and Move left one
step. To set step-back parameters, select “View - Options” and select the “Playback” dialog.
Automatic Pauses
This mode can be useful for more effective transcription. For more information about playback with automatic
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pauses, refer to “Automatic Pauses”.
Using a Foot Control for Controlling Playback
You can control playback using a foot control. This is especially useful, for example, when transcribing sound
data into a text document. You can continue to type without interruption. For more information about using a foot
pedal, refer to “Using a Foot Control”.
Using Speech Enhancements
Before playing a file or during playback, you can use Automatic Gain Control, suppress the level of noise, filter
out ultra-low frequencies, or adjust the tone. Select "Tools - Speech Enhancements". For more information,
refer to “Using Speech Enhancements”.
Playing Files in Stereo
To play a multi-channel sound file in stereo, take the following steps:
1. Open the file in DCR Player.
2. From the Playback menu, click Stereo Parameters.
3. Select “Enable stereo playback” and assign left and right channels.
4. Click OK to save your settings.
5. Start the playback.
To stop playing a file in stereo, stop playback and then from the Playback menu, click Stereo Playback.
Stopping Playback
To stop playing, click on the

3.2.2

button or select “Audio - Stop“.

Using Online Playback
You can use online playback in DCR Player to play a file that is currently being mirrored. This is useful when
you want to start transcribing a file while it is still being recorded.
To play back a file in online mode, take the following steps:
1. From the File menu on DCR Player's main window, click Open.
2. Select the file currently being mirrored from the mirror directory. The file opens in online mode and you can
then use some of the playback features.
When you open a file in online mode, the bookmarks and notes are not available, and some features such as
exporting the file and finding text are not available.
Once a sufficient amount of data has been mirrored, the slider will be enabled, allowing you to navigate within
the file.

3.2.3

Automatic Pauses
You can use the “automatic pauses” mode for controlling playback. This is especially useful, for example,
when transcribing sound data into a text document. You can continue to type without interruption.
Before you Begin Playing
Set autopause parameters, if they have not been set. Select “View - Options”, select “Playback”, and choose
your “Playback with automatic pauses” settings.
Starting Playback
After setting your autopause parameters, you can start the playback and indicate that you want automatic
pauses. Click the

button on the main toolbar, or select “Playback - Automatic Pauses” then click on the
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button.
Changing the Autopause Parameters During Playback
You can change parameters during playback using the “Autopause parameters” dialog.
1. Select “Playback - Autopause Parameters” or use the Ctrl+Alt+Q hot key to launch the following dialog. This
dialog shows the current settings and allows you to change any of these values. The “Last value” column
shows the previous values you used.

2. Choose your settings for each of the following:
- Specify the duration of continuous playback, in seconds.
- Specify the size of the pause, in seconds.
- Specify the size of step back, in seconds.
You can also click on “Enable automatic pauses” to enable/disable automatic pauses during playback.
3. Click OK.

3.2.4

Playback with Different Speeds
You can change the playback speed. This is useful for quick searches and for more effective transcription.

To change the playback speed of a sound file, use the
playback (

). To increase the speed, click on the

buttons, which are visible during

button, or from the “Playback - Speed Play” menu, select

“Increase”. To decrease the speed, click on the
button, or from the “Playback - Speed Play” menu, select “
Decrease”. To restore the normal speed, click on the “x1” button, or from the “Playback - Speed Play” menu,
select “Normal”.
The speed can be changed in a range from 0.5 times up to 3 times the normal speed. You can set the step
used to alter the speed using the “View - Options - Playback” dialog.
For quick access to these functions you can use global hot keys. For more information about global hot keys,
refer to “Using the Hot Keys Dialog”.
Playback usually starts with normal speed. However, you can use the “Retain altered playback speed” option,
in the “View - Options - Playback” dialog, to retain a speed for the next play. Note that the value of the last
speed works only within the same session of DCR Player.
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Using Speech Enhancements
You can use speech enhancements that make speech more distinguishable.
To use speech enhancements:
From the DCR Player main window, select "Tools - Speech Enhancements". The following dialog appears.

Automatic Gain Control
You can use Automatic Gain Control (AGC) to control the sound level of speech recording during playback. By
default, this feature is turned on.
To use Automatic Gain Control, select the "Use Automatic Gain Control (AGC)" check box.
Filter out ultra-low frequencies
You can use a filter out ultra-low frequencies, less than 125 Hz, when playing back a recording. This is useful
for reducing the noise caused when someone bumps a microphone. By default, this option is turned on.
To use filter out ultra-low frequencies, select the "Use low-cut filter" check box.
Noise suppression
You can enhance the quality of reproduced sound by suppressing unwanted noise in a recording. By default,
this option is turned on.
To use noise suppression, select the "Use noise suppression" check box and move the slider to indicate the
level of reduction.
The recommended value is 80%. Normally, noise is suppressed in the mixed result as opposed to
suppressing noise for each channel individually. If this does not have the desired result, you can change this
setting on the Advanced Playback Settings dialog.
Adjusting the Tone
You can adjust the tone of a recording.
To adjust the tone, select the "Use tone control" check box and move the slider to the left for more bass; move
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the slider to the right for more treble. The center position means the file is played back with no change in tone.
Note that it takes 1-2 seconds before the change takes place.
Automatic Gain Control and noise suppression can also be used when exporting a recording file to different
formats. More information can be found in those sections dealing with export operations.

3.2.6

Using the Channel Activity Detector
The Channel Activity Detector (CAD) is an audio processing algorithm that detects changes in channel activity.
This algorithm can be used to automatically insert a bookmark into a recording (only for recording files created
in Digitaly Court Recorder) each time a different channel becomes most prominent. These bookmarks can be
inserted as a recording is taking place or during transcription playback. CAD is also used with the “Jump to
Next Activity” feature in DCR Player to find the next occurrence of a specified channel.
CAD analyses a recording file and inserts bookmarks in the places where the activity of a channel starts (e.g.
someone starts speaking into the microphone). This is to help the operator quickly identify the beginning of
each required statement.
A CAD-inserted bookmark is represented by the

icon and its Speaker field contains one of the following:

ch#n - where n is the number, or name (if assigned), of the channel in which CAD detected the beginning of
activity.
Multiple speakers - indicates CAD detected activity in more than one channel within a specified interval.
For CAD to work correctly, it is very important to have good quality recording files. It is recommended you
carefully set the recording levels of each channel and place the microphones correctly before starting to record.
Microphones for different channels should be set as far apart, and as close to the speakers, as possible.
Choosing CAD Settings
There are two settings you choose that affect the insertion of CAD bookmarks. These are Sensitivity and
Activity interval after detection. Once the CAD ends, you can play the recording file and check if the
bookmarks were inserted correctly. If necessary, you can delete all of the CAD-inserted bookmarks, change the
settings, and start the process again.
The Sensitivity setting indicates the sensitivity of the CAD algorithm to sounds. It has three values: Min.,
Medium, and Max. Increasing the sensitivity means that quieter sounds, such as footsteps, may be detected
by the algorithm.
The recommended setting for a good quality recording (i.e. the recording level above medium and the
channels are well separated) is Min. or Medium. This will lessen the number of false triggers and decrease
the total number of CAD bookmarks. For poorer quality recordings (i.e. the recording level is low with a lot of
noise), the recommended setting is Medium or Max. However, this could increase the number of false triggers
and the total number of CAD bookmarks.
The Activity interval after detection field determines what goes into the Speaker field for a CAD-inserted
bookmark. It is the minimum time period, in seconds, during which a channel is considered active from the
moment it is detected as active. The default is 1 second.
This setting helps determine if the detection of channel activity will be labeled as a single-channel activity
bookmark or as a multi-speaker bookmark. It specifies the interval of time in which sound from another
channel (e.g. a second person talking) will cause the Speaker field in the bookmark to read “Multiple speakers”
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instead of just a single channel. The optimal value of this setting depends on how often the active channels
change.
Example
For example, assume the “Activity interval after detection” is set to 4 seconds and channel 1 becomes active at
5 seconds. If another channel does not become active within 4 more seconds then the bookmark is inserted
with “ch#1” in the Speaker field. If a second, different channel becomes active during this 4-second interval
then the bookmark is inserted as a “Multiple speakers” bookmark.
Using CAD during Playback
To use the Channel Activity Detector during playback, take the following steps:
1. Open a recording file.
2. From the DCR Player main window, select "Tools - Channel Activity Detector". The following dialog
appears.

3. Move the Sensitivity slider to select the sensitivity.
4. Select the number of seconds for the Activity interval after detection field.
5. Click the Start Detection button.
Using the Jump to Next Activity Feature
The “Jump to Next Activity” feature in DCR Player can be used to find the next occurrence of a specified
channel. Before using this feature, you should review your settings under “Tools - Channel Activity Detector”.
From the Playback menu, click Jump to Next Activity and then click the channel name or number.
Alternatively, you can use the shortcut Ctrl + Shift + n to jump to the next occurrence of channel n.

3.2.7

Playing Back Channels
You can control which channels are being played back. This allows you to listen to all channels
simultaneously, listen to a particular channel, or listen to any combination of channels.
Selecting Channels
Select channels from the “Playback - Playing Channels” menu or using your mouse or a hot key.
When you select a channel, the result depends on the mixed mode that has been set.
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To set this mode, do one of the following: use the
button to the right of the channel number buttons, click “
Playback - Playing Channels - Enable Mixed Mode”, or use a global hot key (for more information, see "Using
the Hot Keys Dialog").
When the button looks like
, mixed mode is switched off. This means the program can play only one
channel at a time or all channels together. Selecting a channel causes only that channel to be selected.
When the button looks like
, mixed mode is switched on. This means the program can play any
combination of channels you choose. Selecting a channel causes that channel to be selected in addition to
the channels already selected.
You can also use Ctrl+Click or Shift+Click to select more than one channel. And you can use a foot pedal to tab
through the different channel selections.
Displaying recording level for each channel
When DCR Player plays a sound file, the composite recording level is displayed on the right-hand side of the
dialog. In addition, the sound level of each channel appears, as shown below. The
channels are active.

icon shows you which

Changing the recording levels for individual channels
You can adjust the levels for each channel individually by using the sliders to the right of the channel level
indicators, as shown below.

The default level for each channel is 100% (i.e. the level is not changed). For this default level, the slider is in
the center position. You can adjust the level from 25% to 400%. To restore the default level for all channels to
100%, use the

3.2.8

button.

Playing a File Streamed over an IP Network
The DCR Player supports audio and video playback over an IP network.
To begin playback, take the following steps:
1. From the File menu on DCR Player's main window, click Open URL.
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2. In the URL field, enter the URL of the file to be played back.
The file will be opened and you can then play back the file with some restrictions.
Note that all export operations are available when opening a file in this manner.

3.2.9

Opening a File Being Mirrored
Normally, DCR Player can open only a completely mirrored file using the “File - Open URL” menu item. With an
additional module, PlayActiDcrDll.dll or PlayActiDcrDll64.dll, DCR Player can open a DCR file which is currently
being mirrored if a link to this file is distributed through Internet Information Services (IIS).
The following describes how to set up IIS 7.5 on Windows 7 to enable the reading of a DCR file that is being
mirrored.
1. Check that you have installed the “ISAPI Extensions” feature (Control Panel - Programs and Features - Turn
Windows features on or off, Internet Information Services - World Wide Web Services - Application
Development Features - ISAPI Extensions tree item).
2. Start Control Panel - Administrative tools - IIS Manager.
3. Create and configure a virtual folder for the directory with mirrored copies of your DCR files, as described
below:
Create a virtual folder with an alias. This example uses an alias of "DCRMirr".
Turn off caching for "DCRMirr" by taking the following steps: Select "DCRMirr" in the left pane; select
"Output Caching"; select "Add..." from the Actions pane; specify ".dcr" for the extension and select
"Prevent all caching" for all types of caching. In a similar manner, turn off caching for the ".dcr_footer"
extension.
Add the MIME type for DCR files by taking the following steps: Select "DCRMirr" in the left pane; select
"MIME Types"; select "Add..." from the Actions pane; specify ".dcr" for the extension and "application/
octet-stream" for the MIME type.
4. Add Handler Mapping for the ".dcr_footer" extension by taking the following steps: Select your web site (e.g.
"Default Web Site"); select "Handler Mappings"; select "Add Module Mapping..." from the Actions pane;
specify "*.dcr_footer" as the Request path, select IsapiModule from the Module list, specify the full path to the
PlayActiDcrDll64.dll (for 64-bit system) or PlayActiDcrDll.dll (for 32-bit system) as the Executable, and a
name (for example ,"DCRHandler") as the Name. Click "Request restrictions..." button. On the "Mapping" tab
uncheck "Invoke handler only if request is mapped to" box. After clicking "OK", you will be prompted to add an
"Allow" rule. Agree with the prompt.
5. It is recommended you turn on server logging.

3.3

Using the Selection Panel
The Selection panel in DCR Player lets you select a part of a recording. The main use of this feature is to allow
you to export part of a file.
An example of the Selection Panel is shown below:

Selection Panel Buttons
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You can use the following buttons on the Selection panel and the corresponding items on the Selection menu:

Button

Description

Selection Menu

Shortcut Key

Set the left selection boundary to the current
slider position.

Set Beginning of
Selection

Ctrl + Shift + P

Move the current position of the slider to the left
selection boundary.

Go to Beginning of
Selection

Clear the selection.

Clear Selection

Move the current position of the slider to the right Go to End of Selection
selection boundary.
Set the right selection boundary to the current
slider position.

Set End of Selection

Ctrl + Shift + T

Position the selection boundaries. The selection
boundary moves 1 second left and right. The
main slider’s position does not change. The left
set of buttons is for positioning the beginning of
the selection; the right set of buttons is for
positioning the end of the selection.
Stop playing at the next selection boundary.

Stop Playing at Selection
Boundary

Below the buttons, the following information appears when you make a selection:
Absolute and relative times of the beginning of the selection.
Size of the selection, in units of time.
Absolute and relative times of the end of the selection.
You can show or hide the Selection panel. From the Selection menu, click Show Selection Panel.

3.4

Using the Assistive View
A special view is available in the DCR Player to meet the requirements for compliance with Section 508 of the
Rehabilitation Act.
To activate or deactivate this view, take the following steps:
1. Close any open recording files and predefined bookmark files.
2. From the View menu, click Assistive View.
3. Restart the program.

3.5

Using the Thin View
The DCR Player has a "Thin View" to reduce the information in their main windows. This mode frees up screen
space and allows more room for you to work with other applications on your computer.
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Note: The Thin View always works in the “Always On Top” mode.

To display the Thin View, click the

button on the main toolbar or select “View - Thin View”.

The “Thin View” reduces the main DCR Player window to a single bar with a minimum set of controls. The
following is an example of the Thin View for DCR Player:

The Thin View consists of the following elements:

Element

Description
Open file
Play
Change playback speed (visible only during playback)
Pause/continue
Stop
Rewind to beginning
Left (one step)
Current position in sound file
Right (one step)
Select channels to play
Restore main window
Close application

Current position indicator
The indicator of the current position has the following display modes.
- shows the absolute time (hh:mn:ss AM or PM) of the current position.
- shows time (hh:mn:ss) from the beginning of the file to the current position.
- shows time (-hh:mn:ss) from the current position to the end of the file.
To switch modes, click anywhere in the indicator area.
Moving the Thin View
To move the Thin View, click in the window area outside of any button, and drag it to the desired location on
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your screen.
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Using the Sound Image Window
From DCR Player, you can display a graphical representation of sound data. This allows you to display the
audio levels across an entire recording file and look for spots of low volume or parts that include spoken
words.
From the View menu, select Sound Image Window. The following is an example of the Sound Image Window:

The window contains two main parts: a ruler at the top and a large graph below.
The ruler shows the entire file and you can double-click in the ruler to adjust the graph below to that position
allowing you to navigate through the file.
The graph below shows a scalable image of the sound data. You can change the representation of the graph
by right-clicking on the graph and choosing “Show as level” or “Show as wave”. From this graph, you can use
buttons or a right-click menu to zoom in and out by time or by level. The Zoom Level controls adjust the audio
level scale on the left side of the dialog; the Zoom Time controls change the time scale of the graph.
Other characteristics of the Sound Image Window are:
Vertical lines represent bookmarks. You can hover your mouse over these to display more information.
A red vertical line shows the current position.
A green point represents the level of sound at that point
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You can drag your mouse to select part of the sound data in either the ruler or the graph, which is similar to
making a selection on DCR Player’s main window.

By clicking the

button, you can change the following sound image settings:

Use voice detection - select this check box if you want the parts of a recording file that include spoken words to
be highlighted with a pink background. You can use the slider below to adjust the sensitivity to speech.
Show bookmarks - clear this checkbox if you want to suppress the display of bookmarks.

3.7

Using Digital Certificates
You can use digital certificates to ensure that a recording has not been changed after it has been recorded.
Both local certificates and TSA (Time Stamp Authority) certificates are supported.
To use this feature, you must obtain a certificate with a private key from your own certificate server or purchased
from a company such as Verisign, or you can use a Time Stamp Authority (TSA) certificate.
To sign the file you have open in DCR Player, take the following steps:
1. From the File menu, select Sign. The following dialog appears:

2. Select whether you want to use local certification for signing or Time Stamp Authority for signing.
3. For local certification, select the certificate you want to use. You can use the View button to display
information about the certificate. For TSA certification, select the TSA server you want to use.
4. Click Sign.
This will use the certificate you have chosen to sign the media data, consisting of the audio and video, and to
sign the bookmarks. The signature will ensure that an unauthorized party has not edited the recording file.
The signature can be automatically verified when a recording file is opened in DCR Player by selecting an
option on the General tab. Alternatively, you can manually verify a recording file’s signature by selecting Verify
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Signature from the File menu. This checks the validity of the signature for the media data and the signature for
the bookmarks, and it indicates whether the contents have been modified.

3.8

Using a Portable Version of DCR Player
Once you have installed DCR Player on a PC, you can create a portable version of the program. This will allow
other users to use this portable version without the need to install the program onto their PCs.
Before Creating a Portable Version of DCR Player
Before you create a portable version of the program, take the following steps on the PC where you will be
creating the portable version:
1. Set your configuration options for DCR Player. Many of these settings will be used in the portable version.
2. If you are using a video codec to encode recorded video in MPEG-4 part 2 format (e.g. XVID, DIVX, etc.) then
you should ensure the codec’s files are on the machine where you are creating the portable version. The
required files will then be included when you create the portable version.
3. If you are using the H.264 video codec to encode recorded video then you should ensure the codec’s files
are on the machine where you are creating the portable version. The required files will then be included
when you create the portable version as long as you specify you want to add support for H.264 decoding.
Contact BIS Digital Inc. for further assistance.
Creating the Portable Version
To create a portable version of the program, take the following steps:
1. From the Tools menu of DCR Player, click Create Portable Version. The following dialog box appears.

2. Specify the folder where the portable player will be saved. Write down this location as you will need to
reference it later.
3. Select where you want to store the configuration options. They can be stored in the Windows registry or in
a .cfg file in the portable player’s folder. Usually, they will be stored in the registry.
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4. If you want to include support for H264 decoding, select “Add support for H264 decoding” and specify the
location of the folder that contains the H264 decoding engine. This is required only if the portable version
will be used in a Windows XP environment as Windows 7 has an H.264 decoder built-in.
5. Click Create.
A folder named PlayerProgram will be created in the location you specified. This contains the files and folders
required to run the portable version.
Launching the Portable Version
To launch a portable version of the player, navigate to the PlayerProgram folder on the CD/DVD and then
double-click the Player.exe file.
Changing the Location of your Configuration Settings
From the Tools menu, click Portable Version Settings. This allows you to change where configuration options
are stored.
Restrictions on Using the Portable Version
There are some restrictions when using the portable version. The following features are not available:
Export to PDF,
Export to Video DVD,
Import/Export configuration settings,
Foot control,
Use indexing service for faster searches,
Associate program with DCR files,
Creation of hidden trace files.

3.9

Foot Control

3.9.1

Using a Foot Control
You can control playback using a foot control. This is especially useful, for example, when transcribing sound
data into a text document as it allows you to continue typing without interruption.
DCR Player supports the Infinity Foot Control connected to a USB port.
After connecting the foot control, you must adjust settings in the “Options - Foot Control” dialog and run the
Foot Control Wizard. The Foot Control Wizard sets the mapping of events for use with DCR Player.
Using the “Pedal Functions” dialog you can associate a function with each foot pedal.
Instead using a foot control for transcription, you can also use hot keys. For more information, refer to “Using
the Hot Keys Dialog”.
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Associating Functions to Foot Pedals
The “Pedal Functions” dialog looks like this:

This dialog lets you assign functions for each device pedal and enables you to control the playback of sound
data.
Step back by x sec. - move backward from current position each time the pedal is pressed. You can adjust the
size of the step from 1 to 999 seconds.
Rewind with n times normal speed - rewind from the current position while the pedal is pressed. You can
adjust the speed from 0.5 times to 3 times the normal speed.
Play while pressed / Pause when released - play while the pedal is pressed; pause when the pedal is
released. Pause keeps the video window active.
Play while pressed / Stop when released - play while the pedal is pressed; stop when the pedal is released.
Stop goes to a black video window.
and step back by x sec. when released - automatically move backward from the current position when the
pedal is released from being paused or stopped. You can adjust the size of the step from 1 to 999 seconds.
Step forward by x sec. - move forward from current position each time the pedal is pressed. You can adjust
the step from 1 to 999 seconds.
Forward with n times normal speed - fast forward from the current position while the pedal is pressed. You
can adjust the speed from 0.5 times to 3 times the normal speed. When using this option it may be useful to
automatically step back a specified number of seconds when you release the foot pedal. You can specify the
number of seconds in the "and step back by x sec. when released" field.
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Switch between the playing channels - tab through the channel selections: All channels, Channel 1, Channel
2, and so on.

3.9.3

Using the Foot Control Wizard
The Foot Control Wizard helps you map events for your foot control. For more information about using a foot
control, refer to the “Using a Foot Control” section of this document.
You can run this wizard at any time by selecting “View - Options - Foot Control” and clicking on the “Foot
Control Wizard” button.
Before running the Foot Control Wizard, you should connect your foot control to your PC.
The Foot Control Wizard consists of the following pages:
A Welcome page
Choice of device
Analysis and mapping of pedal movements
Completion of Foot Pedal Wizard.
Analysis and mapping of pedal movements
The page looks like this:

To analyze and map the pedal movements, take the following steps:
1. Click the “Start” button to start the Foot Control Wizard.
2. Press and release the pedals of your device, as follows:
For a 2-pedal control: press the left pedal, release the left pedal, press the right pedal and release the
right pedal.
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For a 3-pedal control: press the left pedal, release the left pedal, press the middle pedal, release the
middle pedal, press the right pedal and release the right pedal.
3. Click the “Stop” button to stop the Foot Control Wizard, if it has not stopped automatically after releasing the
last pedal. A message appears indicating whether or not the wizard was able to successfully set map the
pedal movements.
If the red indicators do not light up while you press the pedals, the Foot Pedal Wizard cannot map the pedal
movements. This can be caused by the following:
Your device is switched off, it is not connected, or it does not work properly.
You have a non-standard device and the Foot Pedal Wizard was not able to detect the pedal movements.

3.10

Bookmarks

3.10.1 Working with Bookmarks
Bookmarks allow you to:
navigate quickly in a sound file.
store notes at chosen positions in a sound file.
redact segments of a sound file.
work with file attachments, such as evidence documents.
store time points in a recording by using auto-bookmarks.
distinguish cases by using a special bookmark called a docket or case-style bookmark.
standardize or classify bookmarks based on color (e.g. use different colored bookmarks to differentiate
sensitive information).
seal all of a recording or parts of a recording (only for recording files created in Digitaly Court Recorder).
display channel activity with the use of CAD-inserted bookmarks.
Bookmarks are automatically created during a recording at regular time intervals and for certain events, such
as when a recording starts. The notation for each bookmark consists of the date (mm/dd/yy), the time of
occurrence (hh:mn:ss), and the short name of the event. For example:
• 10/24/2004 11:20:23 PM - Start Recording
In addition to automatic bookmarks created during a recording, you can manually create bookmarks
You can redact segments of a sound file and choose whether they are played back or exported. For example,
this allows you to omit parts of a recorded file when it is played back in room. During playback, a redacted
segment can be played, skipped, or blacked out.
Optionally, you can exclude different parts of a file when exporting a .dcr file to another file or when exporting
bookmarks to a text file.
Displaying the Bookmarks Window
To display the Bookmarks window, click the
is a sample display:

button on the main toolbar, or select “View - Bookmarks”. Here
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The bookmarks window consists of a list of bookmarks, sorted by the position within the sound file. Below this
are the fields you can edit.
Customizing the Bookmarks Window
You can customize what information appears on the Bookmarks window and change its appearance. For
example, you can choose which columns of information to display and change the order in which the columns
are displayed across your screen.
You can also use the following options from the View menu:

View Menu Option

Function

Menu bar

Show/hide the menu bar

Toolbar

Show/hide the Bookmarks toolbar.

Show/Hide Toolbar Items

Show/hide toolbar items

Show Auto-bookmarks

Show/hide automatically created bookmarks.

Show Icon

Show/hide the icon in the first column.

Show Date

Show/hide the date in the Time column.

Choose Columns

Select the columns you want displayed and the order in which you want
them to appear.
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You can also use "View - Font" from the main DCR Player window to change the font used for headings and
text fields in the Bookmarks window.
Bookmarks Toolbar
The toolbar allows you easy access to common operations.
On the default toolbar, you can use the following buttons, and associated menu items and shortcut keys:

Button

Description

Bookmarks Menu

New bookmark

Edit - New Bookmark

New docket/case

Edit - New Docket/Case

New attachment

Edit - Attach File

Delete bookmarks

Edit - Delete

Begin seal

Edit - Begin Seal

End seal

Edit - End Seal

Change position or length of bookmark

Edit - Reposition

Highlight a bookmark

Edit - Highlight with …

Find text in file notes

Edit - Find...

Scroll through list of bookmarks as position in
sound file changes

Position - Auto Scroll

Display menus

You can customize toolbar used in the Bookmarks window. For example, you can choose which buttons
appear on the toolbar and the order in which they appear. For more information, refer to “Using DCR Player”.
Customizing the Column Settings
You can customize the look of the Bookmarks window by selecting the columns of information you want
displayed and the order in which they appear across your screen.
Selecting the Columns to Display
To select the columns you want displayed, do one of the following:
Right-click any column title. On the menu that appears, click the name of the column to add it or remove it
from the list of columns to be displayed.
Right-click any column title, and click More. Or, on the View menu, click Choose Columns. The Column
Settings dialog box appears, as shown below. Select the columns you want displayed. You can either click
the check box or click the column title to highlight it and click Show.
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Changing the Order of the Columns
To change the order in which the columns are displayed, you can click the column you want to move, hold your
mouse down, and drag the column to its new position. This is similar to moving columns in Windows Explorer.
Alternatively, you can take the following steps to change the column order:
1. Do one of the following:
Right-click any column title, and select More.
On the View menu, click Choose Columns.
The Column Settings dialog box appears. The names of the columns from top to bottom reflect the order
in which the columns appear from left to right on your screen.
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2. Click the name of the column you want to move to highlight it.
3. Use the Move Up or Move Down button to change the order in which the name of the column appears.

3.10.2 Working with File Notes
You can add notes to a file after it has been recorded. These notes consist of a freeform text field where you
can type any notes for a sound file. They may also contain fixed fields with titles and default values. For
example, you may define specific fields such as Audio Transcriber Name, or other fields you would like to keep
track of.
You can use the DCR Player to add or edit file notes.
To display notes associated with a recording file, click the
Notes”. Here is a sample display:

button on the main toolbar or choose “View - File

To edit notes that contain fixed fields, click the Edit button. Otherwise, you can simply type into the freeform
field.
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You can use "View - Font" from the main window to change the font used in File Notes and bookmarks.

3.10.3 Editing Bookmarks
Creating a new bookmark
If you want to mark a point in a sound file, you can create a positional bookmark by taking the following steps:
1. Use the Slider to set the current position.
2. Use the F2 shortcut, click the
Bookmark.

button on the bookmark toolbar, or from the Edit menu, select New

3. A new bookmark appears in the list and you are placed in the first field below.
4. Type the information you want to store in the new bookmark.
The text of each bookmark you create can consist of two parts - a note and a private note (only for recording
files created in Digitaly Court Recorder). Private notes allow you to store additional information as a separate
part, and you can optionally exclude this information when exporting bookmarks to a text file and when
exporting a .dcr file (see “Exporting File Notes or Bookmarks to a Text File”, “Exporting a File to DCR, WAV, AVI
and WMV formats”). You can show or hide the private notes field at the bottom of the Bookmarks window by
using “View - Show Fields - Show Private Notes”. In a list of bookmarks, you can choose to have the “Private
Notes” column shown by using “View - Choose Columns” and selecting “Private Notes”.
Editing bookmark notes
You can edit the notation of a bookmark by taking the following steps:
1. Select the bookmark.
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2. Click in the “Note” field.
3. Update the notation, as required.
Creating a sealed bookmark (only for recording files created in Digitaly Court Recorder)
You can use sealed bookmarks to seal or protect parts of a recording. Sealed sections of a recording require a
password for them to be played.
To seal part of a recording, click the
button on the bookmark toolbar, or from the Edit menu, select Begin
Seal. The recording will be sealed until an End Seal bookmark is encountered. To create an End Seal
bookmark, click the

button on the bookmark toolbar, or from the Edit menu, select End Seal.

Creating a new docket/case
You can create a special bookmark called a docket or case-style bookmark. This allows you to distinguish
dockets/cases within the same file. This type of bookmark uses a predefined format.
To create a docket/case, take the following steps:
1. Use the Ctrl+F2 shortcut, click the
button on the bookmark toolbar, or from the Edit menu, select New
Docket/Case. The following dialog appears.

2. Complete the information as required. If you want the docket to be sealed (only for recording files created in
Digitaly Court Recorder), select Seal Docket. A password will be required to listen to information pertaining
to this docket.
3. Press OK to add the docket to the list of bookmarks.
Editing a docket/case
You can edit the information in a docket/case, as follows.

62

DCR Player

On the Bookmarks window in DCR Player, select the docket/case, and either click the Edit button or from
the Edit menu, click Edit Docket/Case.
Attaching a file
You can attach files, such as evidence documents, to a recording file. You can open attachments, delete
attachments, seal/unseal attachments, and optionally include them when exporting recording files. File
attachments appear in lists of bookmarks, which means you can work with them just like any other type of
bookmark or docket/case.
To attach a file, take the following steps:
1. Click the
appears.

button on the bookmark toolbar, or from the Edit menu, select Attach File. The following dialog

2. Locate and select the file you want to attach.
3. Optionally, add any notes in the Notes field.
4. If you want the attached file to be sealed within an unsealed section of the recording, select Seal
attachment (only for recording files created in Digitaly Court Recorder). Note that by default, an attachment
is automatically sealed if it is inserted within a sealed section of the recording. A password will be required
to display the information in a sealed attachment.
5. Click the Open button to add the attached file to the list of bookmarks.
Opening an attached file
To open a file attachment in a recording, select the attachment in the list of bookmarks, and then from the Edit
menu, click Open Attached File, or click the Open button in the bottom part of the dialog box. The attached file
will be opened in read-only mode in the corresponding program.
Sealing and unsealing an attached file during playback (only for recording files created in Digitaly Court
Recorder)
During playback, you can seal and unseal files attached to a recording.
To seal an attachment:
Select the attachment in the list of bookmarks, and then from the Bookmarks menu, select Seal Attached
File.
To unseal an attachment:
Select the attachment in the list of bookmarks, and then from the Bookmarks menu, select Unseal Attached
File.
Highlighting a bookmark
To highlight a bookmark with a background color, take the following steps:
1. Click the bookmark in the list.
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2. Do one of the following:
• Click the left side of the

button to highlight the selection with the current color (as displayed on the

button), or click the arrow on the
button and select the highlight color from the drop-down list. You
can choose "None" to remove a highlight.
• On the Edit menu, select Highlight with Current Color to highlight the selection with the current color, or
click Highlight with… and select the highlight color from the drop-down list. You can choose "None" to
remove a highlight.
Alternatively, you can right click in the list of bookmarks to select the item you want to highlight. From the
shortcut menu, select Highlight with Current Color to highlight the selection with the current color.
Tip: You can press Ctrl+Click or Shift+Click to select multiple items to highlight all at once.
If you want to change the color being used as the current color, based on the color of a bookmark in your list,
take the following steps:
1. Right-click in the list to select the item whose color you want to use.
2. From the shortcut menu, select Update Current Color.
Deleting a bookmark or attachment
To delete a bookmark or attachment, take the following steps:
1. Click the bookmark or attachment in the list.
2. Click the

button on the bookmark toolbar, or from the Edit menu, select Delete.

Repositioning a bookmark
You can change the position of an existing positional bookmark by taking the following steps:
1. Use the Slider to set the new position.
2. Select the bookmark.
3. Click the

button on the bookmark toolbar, or from the “Edit” bookmark menu, select “Reposition”.

3.10.4 Displaying a History of Bookmarks
A complete history of all of the bookmarks associated with a recording file is kept. You can use DCR Player to
display the bookmarks as of a particular date and time.
To display the bookmark history:
1. From the File menu, click History. The following dialog box appears.
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2. In the As of field, select a past date and time from the drop-down list. A list of the bookmarks as of the
selected date and time appears below.

3.10.5 Using Redaction
DCR Player allows you to use the redaction feature so that redacted segments can be played, skipped over or
blacked out during playback. Redacted segments can also be distorted. For example, you may want to exclude
a particular comment made by a witness during an interview or distort the video so that the person being
recorded cannot be visually recognized when playing back the interview in a room. You can also choose
similar options for handling redacted segments in a file when the file is exported.
A redacted segment appears in the Bookmarks window with “Begin Redaction” and “End Redaction”
bookmarks, as shown below.
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You can set the default behavior of new redacted segments as a configuration option.
Creating a Redacted Segment
To create a redacted segment:
1. Use the Selection Panel to select the segment of the recording you want to redact.
2. From the Redaction menu on the Bookmarks window, click New Redaction.
3. In the During playback section, choose the behavior of the redacted segment when the file is being played
back.
4. Optionally, you can add comments in the Notes field.
Distorting a Redacted Segment
The video in a redacted segment can be distorted. If the video is distorted, you can also choose to distort the
audio or to mute it.
To use distortion, take the following steps:
1. If the Video Preview window is not displayed, from the View menu, click Video Window to open it.
2. Using the Selection panel, select a begin point and an end point for the area of the file to be distorted. This
area may be a small segment of the file, or it may be the entire file.
3. From the Redaction menu on the Bookmarks window, click New Redaction. A “Begin Redaction” bookmark
and an “End Redaction” bookmark will be entered into the bookmarks area. These bookmarks will be
consistent with the beginning and ending points of the area identified in the Selection panel.
4. In the “During playback” section on the Bookmarks window, select “Distort media in this segment”.
5. Return the playback position pointer to the beginning of the redaction.
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6. Click the Play button to start to play the file.
7. Click the Settings button. This will cause playback to pause.
8. Select “Use Video Distortion in this video stream”. By default, the entire frame is visually distorted. You can
choose to distort a constant region or use face tracking to track a face throughout the video stream. For more
information on the options available for distorting the video, refer to "Distorting Video in Redacted Segments"
.
9. If you also want the audio either distorted or muted then select “Use audio distortion with type”. Select “Mute”
to mute the audio or select “Vocoding” to distort the audio. The latter uses a voice encoder to distort the
audio such that it can be understood but the person’s voice cannot be recognized. Note that you can adjust
the voice encoder settings from the “View - Options - Redaction” dialog box.
10.Once you are finished, click OK to continue playback.
Deleting a Redacted Segment
To delete a redacted segment:
1. Select either the “Begin Redaction” or “End Redaction” bookmark for the segment.
2. From the Redaction menu, click Delete.
This doesn’t remove any data from the file. It simply changes a segment so that it is no longer redacted.
Repositioning a Redacted Segment
To reposition a redacted segment:
1. Use the Selection Panel to highlight the new starting and/or ending points.
2. Click either the “Begin Redaction” or “End Redaction” bookmark for the redacted segment you want to
reposition.
3. From the Redaction menu, click Reposition.
Selecting Part of the Recording Based on a Redacted Segment
1. To select the part of a recording that corresponds to a redacted segment, click either the “Begin Redaction”
or “End Redaction” bookmark for the redacted segment.
2. From the Redaction menu, click Set Selection. In the main window, the slider will reflect the corresponding
redacted segment.
Exporting Files with Redacted Segments
When you export a file that contains redacted segments, you can choose to ignore (include) all of them, skip
(do not include) all of them, black all of them out, or use the individual bookmark setting for each redacted
segment.
Playing Files with Redacted Segments
When playing back files that contain redacted segments, the default behavior is to use the individual setting for
a redacted segment to determine whether it will be played, skipped, or blacked out. In some cases you may
want to override this behavior, for example, to play, skip, or black out all redacted segments during playback.
To change the behavior for redacted segments, from the Redaction menu, click Playback and then choose
one of the menu items.
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3.10.6 Distorting Video in Redacted Segments
Distorting the video in a redacted segment of a recording file includes the following features:
The use of a face detection algorithm that automatically detects a face in a frame.
Automatic face tracking can dynamically change the area of video being distorted.
Using your mouse, you can use manual face tracking to change the area being distorted.
Different intervals within a redacted segment can have different distortion modes. For example, one interval
can have the entire frame distorted while another interval can use automatic face tracking.
You can edit the intervals of distortion and preview the results of the distortion.
A redacted segment can be divided into one or more independent intervals. For each interval, you can choose
one of these distortion modes: Entire frame, Constant region, Automatic face tracking, or Manual face tracking.
Once you have created a new redacted segment, select Distort media in this segment and then click the
Settings button. The dialog below appears. Note that, by default, the new segment will consist of one interval
with a distortion mode of “Entire frame”. Use this dialog along with the Video Preview window to specify the
video distortion.
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Distorting a Constant Region
This option is useful when the subject remains in the same position throughout the interview. The same
region can be distorted throughout the video.
For the mode of distortion, select Constant region.
To adjust the region being distorted, in the Video Preview window, click and hold your mouse down, and then
drag your mouse to adjust the area to be distorted. Alternatively, you can use the drop-down lists in the
“Region” section to adjust the settings and monitor the corresponding area in the Video Preview window.
Optionally, you can select the “Enable effect” check box and use the Play button to display the area being
distorted. You can then adjust the region being distorted using your mouse or the drop-down lists.
Using Face Tracking
A face can be tracked automatically or manually.
Automatic face tracking moves the distortion area around the video automatically so that the subject’s face is
always distorted.
The first step in automatic face tracking is to find the correct face. The second step is to track this face as it
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moves around the video. DCR Player uses a face detection algorithm to automatically find a face in a frame.
Alternatively, you can manually indicate the location of the face to be distorted in the video.
If you want to use automatic face tracking, click the Start Face Detection button. When a face is detected, you
are prompted to accept the result. You can either click “Accept” to accept the face as the correct one, or click
“Continue” to look for another face.
Once the correct face has been accepted, click the Start Calculation button. The program will watch for breaks
in the recording where automatic face tracking cannot find the face. In such a case, the calculation will create a
list of intervals where each interval shows where automatic face tracking lost the position of the face. This
could be because the face went out of view or because the person turned his or her head. These intervals can
be processed independently.
If automatic face tracking does not produce the desired results, you can use manual face tracking. For
example, if the subject continually looks away from the camera then the automatic facility may lose track of
where the face should be located. If later, the subject looks back at the camera but for too short a period of time
for the tracking facility to recognize the face then the face will be exposed briefly and it will not be distorted.
If you want to manually track the area to be distorted, select Manual face tracking and then click the Start
Adjusting button. Use the mouse to track the face around on the Video Preview window. The mouse movement
defines where the distortion area will be made. Click the Stop Adjusting button when you are complete.
Processing Intervals
If the automatic face tracking calculation was not successful, one or more new intervals will be created. If an
interval has "Object was lost" in the Note column then it indicates that the automatic face tracking algorithm lost
track of the face. These intervals will need to be processed separately.
To process one of these intervals, take the following steps:
1. In the list of intervals, double-click the interval to start at the beginning of the interval. You can try to restart the
automatic face tracking for this interval.
2. If the result is unsuccessful:
a) Change the distortion mode to Manual face tracking.
b) Click the Start Adjusting button and use your mouse to manually move the distortion area over the
subject’s face.
If automatic or manual tracking does not work very well, you can choose “Constant region” for the distortion
mode and set a fixed position for the area, or you can choose “Entire frame” to distort the entire frame.
The control buttons below the “List of intervals” allow you to work with the intervals in the list. For example, if
you want to change an interval from “Automatic face tracking” to “Entire frame” and also change the moment at
which it switches to “Entire frame” by a second or two then you can use these buttons. You can also delete
intervals or create new ones.
Example of Automatic Face Tracking
The following is an example of using the automatic face tracking feature.
1. Once you have created a new redacted segment, select Distort media in this segment and then click the
Settings button.
2. Click the Start Face Detection button. This causes the program to search the video for a face. The green
frame in the video window below shows a face that has been found.
3. If you are satisfied with the result, click Accept on the confirmation box below. This will create a new interval
on the list with the distortion mode of “Automatic face tracking”. This interval starts at the position where the
face was detected. The interval from the beginning of the redacted segment to the beginning of this interval
will have a distortion mode of “Entire frame”.
4. Click the Start Calculation button. The program will attempt to track the face as it moves around the video.
5. If the calculation is successful then you can select the “Enable effect” check box and the Play/Stop buttons to
preview the results.
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3.10.7 Using Special Characters
You can use special characters and symbols that don't appear on your keyboard for the text you type in different
places, including the following:
Fields for bookmarks, including notes.
Text field when using "Find in Files" to search files.
Text field when using "Find in LWA" to search files processed by Liberty Web Access.
Text field when using "Find Text in Notes" to search notes.
Text area of the Text Substitution window.
For example, you can use international characters such as à and ë, or symbols such as ¢ and ¼ .
Inserting a Special Character
To insert a special character or symbol, take the following steps:
1. Click where you want to insert the character.
2. Use the Symbol dialog box to insert the character. You can access this dialog from the following places:
Location

To access…

Main window

On the Tools menu, select Insert Symbol.

Docket/Case dialog box

Click the

The Symbol dialog box is shown below.

button.
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3. Double-click the character you want to insert.
Alternatively, you can select the character and click Insert, use the "Shortcut key" displayed in the Symbol dialog
box, or press Alt+ the symbol code. If you click Insert and Close, the symbol will be inserted and the Symbol
dialog box closes.
Note: The "Symbol code” that appears on the Symbol dialog shows you information regarding the standard
Windows key combination for entering a character. If you know the character code for a character, you do not
need to open the Symbol dialog box. You can simply click where you want to insert the character, hold down
the Alt key, and use the numeric keys on the right side of your keyboard to type the "Symbol code". This feature
depends on your operating system. You can use this combination to insert a symbol in any text field in any
dialog and is not limited to the places listed above.

3.10.8 Working with Sealed Recordings
You can seal a recording or parts of a recording (only for recording files created in Digitaly Court Recorder).
This secures the sealed sections of the recording and these sections can only be played (unsealed) under
special circumstances. Sometimes the audio may be unsealed permanently and become part of the regular
public record. Other times, the audio may be unsealed temporarily.
During a recording or after a recording has been made, you can seal the recording between a Begin Seal
bookmark and an End Seal bookmark. This causes that section of the recording to be encrypted. Users with
the appropriate security can play back sealed parts of a recording.
Using Security with DCR Player
If you want to use DCR Player to play the sealed sections of a recording, you can use "View - Options Security" in DCR Player to enable security and to specify the same recording password you specified in Digital
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Recorder. You will have complete access to the entire audio and all of the bookmarks that used the same
recording password to secure the file. You can export any part of the audio.
If security is enabled in DCR Player, but either the password has not been specified or it does not match the
password used to encrypt the file you want to play, you will be prompted as you open a sealed recording to
either specify the correct password or to skip the sealed segments.
If security is not enabled in DCR Player then you will not receive any prompts when you open a sealed
recording. Sealed segments will be automatically skipped. This is useful on public-use PCs in the courthouse
where people should not be listening to the sealed portions of recordings.
Exporting a File with Sealed Segments
You can use DCR Player with the correct recording password to export a file with sealed segments. There are
four different options available to deal with the sealed segments.
Export with sealed segments - export the file with all sealed segments. A password is required to listen to the
sealed segments.
Export with sealed segments and a new access password - export the file keeping all sealed segments
encrypted, but access to the sealed segments will require a different access password. Specify and verify an
access password for this file. A user that wants to listen to the sealed sections must supply this same
password.
Export and delete any sealed segments - export the file and delete all sealed segments. Automatic stop/start
bookmarks are substituted to indicate where the sealed segments were removed. This is useful when you
want a recording to be unsealed permanently and made part of the standard public record.
Export and unseal any sealed segments - export the file with all sealed segments unsealed. The sealed
bookmarks are removed. None of the data in the file will require a password for access.

3.10.9 Jumping to Time Points in a Recording
When you open a file, there are time points at regular intervals and also for events such as when a recording
starts or stops. Time points in a file allow you to jump to positions based on absolute time and date values.
The current time position in the file is displayed in the “Time” field in DCR Player’s main window. In the
following example, the recorded file is 5:02 seconds long. The recording is positioned at 3/31/2010 12:32:33
AM, which is 1:22 seconds from the beginning of the file and it is 3:40 seconds to the end of the file.

To jump to a time point, take the following steps:
1. In the main DCR Player window, use “Playback - Jump to time” or press
dialog appears:

on the toolbar. The following
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2. In the “Date” field, select a date from the list of dates that appear in the file. Optionally, you can use the “Set
current position” button to fill the Date and Time fields with the current position.
3. In the “Time” field, specify the time. You can press the
have used, and select a time from the list.

button to display a list of previous time values you

4. Press the “Jump” button. DCR Player jumps to the time/date location in the file, if it exists. Otherwise, the
“Jump to nearest position” dialog appears, from which you can choose the nearest time position (i.e. either
the previous or next).

3.10.10 Finding Text in File Notes and Bookmarks
You can search for text in file notes and bookmarks within an open file.
These programs also have a search facility you can use to find text across a number of DCR files. See "File
Search Facility" for more information.
To find text in file notes or bookmarks within an open file, take the following steps:
1. Do one of the following:
In the Bookmarks window, from the Edit menu, select Find
In the Playback window, from the Bookmarks menu, select Find.
Click

on the toolbar.
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The following dialog appears:

2. In the Find what field, enter the text on which you want to search.
3. If you want to find the exact phrase you typed above, select the Find the exact phrase check box. Otherwise,
the program looks for any of the words you typed.
4. If you want to use a phonetic algorithm, select the Use a phonetic algorithm check box. The Metaphone
algorithm is used unless you have chosen the Soundex algorithm in the Advanced Find Settings dialog box
when using the file search facility.
5. Click the Find Next button to start the search process.
If the text is found, it becomes highlighted in the first instance found. You can then use the Find next button to
find the next instance of the text. You can use the Previous button to display the previous search result.

3.10.11 Replacing Text in File Notes and Bookmarks
You can search and replace text in file notes and bookmarks within an open file.
To find and replace text in file notes or bookmarks within an open file, take the following steps:
1. Do one of the following:
In the Bookmarks window, from the Edit menu, select Replace.
In the Playback window, from the Bookmarks menu, select Replace.
The following dialog appears:

2. In the Find what field, enter the text on which you want to search.
3. If you want to match the exact case, select Match case.
4. In the Replace with field, type the replacement text.
5. Do one of the following:
To find the next occurrence of the text, click Find Next.
To replace an occurrence of the text, click Replace. After you click Replace, the program moves to the
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next occurrence of the text.

3.10.12 Navigation Using Bookmarks
Bookmarks allow you to navigate quickly in a sound file.
To get to a bookmarked position in a sound file, you can do one of the following:
Double click on the bookmark.
Select a bookmark and from the “Position” bookmark menu, select “Go to Current”.
To get to the position of the previous bookmark: from the “Position” bookmark menu, select “Go to Previous”.
To get to the position of the next bookmark: from the “Position” bookmark menu, select “Go to Next”.
Special Bookmarks functions
You can use the following special bookmark functions.
Auto Scroll
When this function is activated, the cursor in the list of bookmarks automatically moves together with the
position in the sound file. For example, you can use this option to automatically see the full contents of each
bookmark while listening to a recording.
To activate this function, check the
select “Auto Scroll”.

button on the bookmark toolbar, or from the “Position” bookmark menu,

Select Closest
This feature finds the closest bookmark to the current position in a sound file. In the Bookmarks window, select
“Position - Select Closest”.

3.10.13 Importing Bookmarks from a BMR File to a DCR File
With Liberty Notes and Liberty Word-Notes, you can create a bookmark file and save it as a BMR file (i.e. with a
file extension of .bmr). Using DCR Player, you can import a BMR file into a DCR file.
Note: To import a BMR file into a DCR file, the DCR file must contain auto-bookmarks for time keeping
To import a BMR file into a DCR file, take the following steps:
1. Open the file in DCR Player.
2. If the Bookmarks window is not displayed, select View - Bookmarks.
3. From the Bookmarks window, select File - Import from BMR file. The following dialog appears:
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4. Select the directory containing the .bmr file.
5. In the File name field, enter the name of the file or select it from the list above.
6. In the File Notes section, select the method for importing the file notes:
Append - the file note from the BMR file is added to the existing one in the DCR file.
Overwrite - the file note in the DCR file is cleared before importing.
7. In the Bookmarks section, select the method for importing bookmarks:
Insert - all bookmarks from the BMR file are added to the DCR file except when an identical bookmark
with the same note text and position already exists in the DCR file. Note that different bookmarks can
have the same position in a DCR file as long as their text is different.
Overwrite - all bookmarks in the DCR file are deleted before the import occurs.
8. Select the destination for bookmark text:
Notes - bookmark text is copied to the note of a bookmark.
Private notes - bookmark text is copied to the private note of a bookmark.
9. Press Open.

3.10.14 Exporting File Notes or Bookmarks to a Text File
You can export text information contained in file notes and in one or more bookmarks to a text file.
To export file notes or bookmarks from a file, take the following steps:
1. Open the file in DCR Player.
2. If the Bookmarks window is not open, from the View menu, select Bookmarks to open it.
3. If you want to export the text from some but not all of your bookmarks, select the bookmarks whose text you
want to export.
4. From the File menu, select Export to Text File. The following dialog appears:
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5. In the File name field, specify the name of the file to which the bookmarks will be saved. This file will be
created automatically.
6. In the Export section, choose whether you want to export the text from all bookmarks or only the text from
those bookmarks that you have selected
7. In the Include data section, select the data you want to export. "(empty)" indicates the field contains no data.
8. Click Save.

3.10.15 Copying File Notes or Bookmarks to the Clipboard
You can copy text contained in file notes or bookmarks to the Windows clipboard.
To copy file notes or bookmarks to the clipboard, take the following steps:
1. Open the file in DCR Player.
2. If the Bookmarks window is not open, from the View menu, select Bookmarks to open it.
3. If you want to copy text from some but not all of your bookmarks, select the bookmarks whose text you want
to copy.
4. From the File menu of the Bookmarks window, select Copy to Clipboard. The following dialog appears:
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5. In the Copy section, choose whether you want to have the text copied from all bookmarks or only from those
bookmarks that you have selected.
6. In the Include data section, select the data you want to copy. "(empty)" indicates the field contains no data.
7. Click Copy.

3.10.16 Printing File Notes or Bookmarks
You can print file notes or bookmarks.
To print file notes or bookmarks, take the following steps:
1. Open the file in DCR Player.
2. If the Bookmarks window is not open, from the View menu, select Bookmarks to open it.
3. If you want to print some but not all of your bookmarks, select the bookmarks you want to print.
4. From the File menu, select Print. The following dialog appears:
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5. In the Print section, choose whether you want to print all bookmarks or only those bookmarks that you have
selected.
6. In the Include data section, select the data you want to copy. "(empty)" indicates the field contains no data.
7. In the Include area section, select any of the following:
Title of document - include a title at the beginning of the output. Select this option to customize the title.
Header - include a header on each page of the output. Select this option to customize the header.
Footer - include a footer on each page of the output. Select this option to customize the footer.
You can click the
button to include the file name within the title, header, or footer. You can click the
button to include the current time within the title, header, or footer.
8. Click Format to change the font, set options for page numbers, or to indicate whether bookmarks should be
printed in color.
9. Click Page Setup to change the default page settings.
10.By default, the output will be printed to your default printer. If you want to choose another printer or set other
printer options, click Advanced Print.
11.Click Print.

3.10.17 File Search Facility
You can search for text in DCR files. You can search files and docket/case-specific fields, search by date or a
date range, use a phonetic algorithm, show the results as a list of files and a list of dockets, search for an
exact phrase, specify a list of folders to search, and so on. For example, you can search all files for "red
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corvette", Judge Simpson, or docket/case number 007. Information about the file or docket/case can be copied
to the Clipboard or you can send one or more of the files to a folder, DVD, USB drive, etc..
This search facility uses the built-in Windows Search to enable faster searches. To use Windows Search, you
must configure the PC on which the files are stored to index the DCR file location. For more information, see
"Setting Up Windows Search".
A separate search facility is available for searching files processed by Liberty Web Access. For more
information, see "Searching for Files Processed by Liberty Web Access".
To search through files, take the following steps:
1. Press the
button in the toolbar, or from the Tools menu, click Find in Files. The dialog below appears.
The fields that appear depend on your Docket/Case Field settings.

2. In the Find what section, indicate what you want to find. The search results must match all of the criteria you
specify. To search for an exact phrase, enclose it in double quotes (e.g. "red corvette"). You can choose from
the following:
Text - specifies the text you want to find.
More/Less button - click this button if you want to search specific docket/case fields. Specify the data on
which you want to search in the relevant fields. You can use the drop-down lists to select previous entries
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you've made.
Date - you can have the search ignore dates, search for a specific date, or search in a date range.
To clear the fields in the "Find what" section, click the "Clear fields" button.
3. In the "Find where" section, indicate where you want the search to look. You can choose from the following:
In files - enter the file-name mask for searching files. This is similar to using Windows Explorer for
searching files. You can use “*” to match any number of characters, and “?” to match a single character.
The default value is “*.dcr”, which means search for all files with an extension of "dcr”. Note that you can
search only through files with an extension of .dcr.
In folder - specifies one or more folders to search. You can type the names, separated by a semi-colon (;)
or click the buttons to the right. Click the
multiple folders.

button to select one folder or click the "More" button to select

Include subfolders - select this option if you want the search to include subfolders of the starting folder.
This is the default.
4. Click the "Search Now" button to start the search. You can interrupt a search at any time by clicking the
"Stop Search" button.
Reviewing the Results
The results of your search are shown at the bottom of the dialog box. The files that match your search criteria
are listed on the "List of Matching Files" tab. The dockets/cases that match your search criteria are listed on the
"List of Matching Dockets" tab. You can sort any column by clicking on the column title.
From the list of result, you can do the following:
Open a recording file - double-click on a line in your search results to open the associated recording file or
docket in Digital Recorder.
Display file information - right-click an item in the list, then click Show Details.
Copy information to the Clipboard - after displaying file information using Show Details, use the Copy to
Clipboard button to copy all of the data in the display or the value of a selected row to the Clipboard.
Send one or more of the associated files to a folder, DVD, etc. - select one or more cases in the list, from the
right-click menu, click Send to, and then select the location for the output. This is the same as the “Send to”
item in Windows Explorer.
Using Advanced Settings
If you don't want to use Windows Search for faster searches, click the "Advanced" button and clear the "Use
Windows Search for faster searches" check box.
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By default, the file search facility uses a phonetic algorithm. This is an algorithm for indexing words by their
sound, when pronounced in English. On the "Advanced Find Settings" dialog box, you can choose not to use a
phonetic algorithm or switch the algorithm that is being used.

3.10.18 Setting Up Windows Search
The file search facility, invoked from "Tools - Find in Files", is designed to use Windows Search for faster
searches. Windows Search is an indexed search on Windows and is the successor to the Indexing Service. To
use Windows Search, you need to specify the locations of your DCR files so that those files can be indexed.
To set up Windows Search for your DCR files, take the following steps:
1. From the Control Panel, choose Indexing Options.
2. From the Indexing Options screen, click the Modify button.
3. Select the folders for your DCR recording files.
4. When you click OK, Windows Search locates the files in the paths you have specified and indexes them. As
new files are added, they are automatically indexed.
For more information, refer to the Windows online help for Windows Search.

3.10.19 Searching for Files Processed by Liberty Web Access
Using DCR Player, you can search for text or fields in DCR files that have been processed by Liberty Web
Access. For example, you can search all files for "red corvette", Judge Simpson, or docket/case number 007.
From the search results, you can open a file for playback or to make changes to it.
To search through files processed by Liberty Web Access, take the following steps:
1. Press the

button in the toolbar, or from the Tools menu, click Find in LWA. The following dialog appears:
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The first time you use this search facility, you will need to configure a connection with the LWA Server. Click
the Settings button and specify the Search and play page in the LWA’s search page field (e.g.
http://127.0.0.1/LWA/LIR_LWA_Ply.htm). Once the connection is established, the search fields,
corresponding to those specified in the LWA Configurator, will appear.
2. In the Find what section, indicate what you want to find. The search results must match all of the criteria you
specify. To search for an exact phrase, enclose it in double quotes (e.g. "red corvette"). You can choose from
the following:
Text - specifies the text you want to find.
More/Less button - click this button if you want to search specific docket/case fields. Specify the data on
which you want to search in the relevant fields. You can use the drop-down lists to select previous entries
you've made.
Date - you can have the search ignore dates, search for a specific date, or search in a date range.
To clear the fields in this section, click the "Clear fields" button.
3. Click the "Search Now" button to start the search. You can interrupt a search at any time by clicking the
"Stop Search" button.
The results of your search are shown at the bottom of the dialog box. You can double-click on a line in your
search results to open the associated file name. Other options may be available depending on your network
configuration.
Once you have opened a file from your search results, you can make changes to bookmarks and file notes,
and insert and delete attachments.
1. From the File menu, click Start LWA editing. This will lock the file and prevent other users from making
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changes to it.
2. Edit the file, as required.
3. From the File menu, click Finish LWA editing. The LWA server makes changes to the stored file and
removes the lock on the file so that other users can work with it.
Note: A lock on a file is also removed if you close the file, open another file, or close DCR Player.
Other options may be available depending on your network configuration. For example, you may be able to
right-click on one of the results, get a link to the file stored in the cloud, copy it to the Clipboard, paste it into an
e-mail, and send it to someone who doesn't have access to the LWA local network.

3.11

Exporting a File to DCR, WAV, AVI and WMV formats
DCR Player supports different types of export operations.
You can export a dcr file to a Windows Media file, wave file, or AVI file so that you can play the file on a machine
that does not have the DCR Player. You can also export a dcr file to another dcr file and choose which
bookmarks, types of bookmarks, video, file notes, attachments, and channels to export. This is useful when
you want to export a multi-channel file and exclude private notes.
You can choose to export part of a file by specifying a time range or export the entire file. If the file you export
contains video then the video portion of the file is exported as well, as long as you are exporting to another dcr
file. When exporting a dcr file, you can choose to export to your hard disc or burn a media disc.
You can also perform the following types of exports:
Export the audio data in a dcr file directly to an audio CD. For more information, see "Exporting a File to an
Audio CD".
Export a dcr file to a video DVD in MPEG-2 format. For more information, see “Exporting a File to a Video DVD
(MPEG-2)”.
Export a dcr file, including bookmarks, audio, video, and attachments to PDF format. For more information,
see "Exporting a File to PDF Format".
Export a dcr file to MP4 format with metadata. For more information, see "Exporting a File to MP4 Format".
This section describes how to export a dcr file to a Windows Media file, wave file, AVI file, or another dcr file.
To export a dcr file, take the following steps:
1. Open the file in DCR Player.
2. If you want to export only part of a file, it is recommended you use the Selection Panel to select the fragment
you want to export. You can adjust this selection later in this process if you need to.
3. Choose File - Export. The following dialog appears.
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4. Select whether you want to export the file to a hard disk or burn the file to a media disc.
5. In the File type field, select the type of exported file. The dialog box changes based on the type of file you
select. Choosing “Copy of complete DCR file” ensures the exported file is an exact copy of the original file
and no further information is required.
6. Complete the fields described below.
Target information: When exporting to your hard disc, you can specify the “Target file” name and location.
When burning to a media disc, you will need to specify the “Target drive” and “Disc type”.
Media format - Optionally, you can select a previously used format from the drop-down list or use the
“Change Format” button to change the file format.
Selection - By default, the entire file will be exported unless you have selected part of the file on the
Selection Panel. You can choose to export part of the file by pressing the "Change Selection” button and
specifying a start time and an end time (using displacement times or absolute times) on the dialog below.

86

DCR Player

Security - By default, any sealed sections of the recording within the file, or part of the file, being exported,
will be deleted. You can use the “Change security” button to change this behavior. For more information,
see "Working with Sealed Recordings".
Redaction - from the drop-down list, you can select the handling of redacted segments. All of them can be
skipped (not included), blacked out, or ignored (included), or each individual bookmark setting can be
used.
Include data - shows the data to be exported. To change the data being exported, use the “Change
Inclusions” button. The dialog below appears.
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You can choose which audio channels and video streams you want to export. When exporting to a DCR
file, you can choose to have all of the audio channels mixed to one as long as the file does not contain
part-time channels.
Other data you can choose to include are as follows, with their abbreviated form in parenthesis: File notes
(F), Notes in manual bookmarks (N), Private notes in manual bookmarks (P) - only for files created using
Digitaly Court Recorder, Attached files (A).
Speech enhancements - when exporting to a non-DCR format, you can use Automatic Gain Control (AGC)
to control the sound level of speech recording during playback and use noise suppression to enhance the
quality of reproduced sound by suppressing unwanted noise in a recording. By default, both of these
options are selected. Click the “Change Enhancements” button to clear either of these options.
Add files in this folder to the export or CD/DVD - select this check box if you want to include additional
files. Specify the location of the folder containing these files in the field below. All files and subfolders from
this folder will be added to the disc. For a CD/DVD, the size of these files cannot exceed half of the
available space on the disc. If a recording spans multiple discs, these additional files are copied to each
of the discs. For example, you can use this field if you have created a portable version of the Player
program on a CD/DVD and want to include the PlayerProgram folder on the disc.
7. Click Export or Burn.
Exporting a file may take a long time. A progress bar indicates the status and the title bar shows the
percentage of the file exported.

3.12

Exporting a File to an Audio CD
You can export the audio data in a dcr file directly to an audio CD. This CD can then be used in any computer
CD-ROM drive or audio CD player.
DCR Player uses the Image Mastering API from Microsoft to export a file to an audio CD. This API is included
as part of Windows Vista (or later).
To avoid creating a very large file and to facilitate playback, you can have the file automatically split based on
bookmarks or file size (in minutes). You can choose to export part of a file by specifying a time range or export
the entire file. You can also export a sealed recording with different options.
To export a dcr file to an audio CD, take the following steps:
1. Open the file in DCR Player.
2. If you want to export only part of a file, it is recommended you use the Selection Panel to select the fragment
you want to export. You can adjust this selection later in this process if you need to.
3. Choose File - Export to Audio CD. The following dialog box appears.

88

DCR Player

4. Complete the fields described below.
Export to - Audio CD by burning - if this option is selected, DCR Player creates an audio (CDDA) disc. You
should insert a blank CD-R/RW disc into your CD drive.
Export to - Audio files on hard drive - if this option is selected, DCR Player creates files on the selected
drive. Select the file type, either wav or mp3. Normally, the default setting is acceptable.
Target drive/folder - specifies either the CD drive, when exporting to CD, or the folder where the files will
be created, when exporting to your hard drive. If this folder does not exist, you will be prompted to create it
during the export process.
File names - displays the naming convention for the files to be created during export. This will be the name
of the file being exported followed by “__cdda__” followed by * to represent a sequential number. The
extension is .wav or .mp3. If the target folder already contains files that match this naming convention then
you will be asked if you want to replace them during the export process.
Selection - By default, the entire file will be exported unless you have selected part of the file on the
Selection Panel. You can choose to export part of the file by pressing the "Change selection” button and
specifying a start time and an end time (using displacement times or absolute times) on the dialog box
below.
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Security - By default, any sealed sections of the recording within the file, or part of the file, being exported,
will be deleted. You can use the “Change security” button to change this behavior. For more information,
see "Working with Sealed Recordings".
Redaction - from the drop-down list, you can select the handling of redacted segments. All of them can be
skipped (not included), blacked out, or ignored (included), or each individual bookmark setting can be
used.
Speech enhancements - as part of the export process, you can use Automatic Gain Control (AGC) to
control the sound level of speech recording during playback and use noise suppression to enhance the
quality of reproduced sound by suppressing unwanted noise in a recording. By default, both of these
options are selected. Click the “Change Enhancements” button to clear either of these options.
Minimum file size is the minimum length, in minutes, of each file that is created during export. This value
must be from 1 to 70 minutes. The default value is 1 minute. This setting applies only when splitting the
file based on bookmarks.
Maximum file size is the maximum length, in minutes, of each file that is created during export. This value
must be in the range from 1 to 70 minutes. The default value is 5 minutes. A file is split once it exceeds its
maximum size regardless of whether the file is to be split based on bookmarks.
Split file based on bookmarks - select this check box if you want to split the file based on bookmarks.
Indicate whether you want the file split based only on docket/case bookmarks or based on any bookmarks.
Once a file has reached the minimum file size specified above, the file will be split based on your
bookmark setting or when the maximum file size is reached, whichever comes first.
5. Click the Export button.
Exporting a file requires a lot of free space on your hard disk. For example, one hour of audio in WAV format
requires about 635 MB. The program first checks how much free hard-disk space is available and issues a
message if there is insufficient space.
Exporting a file to a CD may take a long time. A progress bar indicates the status and the title bar shows the
percentage of the file exported.

3.13

Exporting a File to a Video DVD (MPEG-2)
You can export a dcr file directly to a video DVD in MPEG-2 format which allows it to be played on a home
entertainment system. This operation uses some shareware that can be supplied by BIS Digital or your local
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Digital dealer.
To export a dcr file to a video DVD, take the following steps:
1. Open the file in DCR Player.
2. If you want to export only part of a file, it is recommended you use the Selection Panel to select the fragment
you want to export. You can adjust this selection later in this process if you need to.
3. Choose “File - Export to Video DVD (MPEG-2)”. The following dialog box appears.

4. Complete the fields described below.
Drive - select the target drive for the DVD.
Selection - By default, the entire file will be exported unless you have selected part of the file on the
Selection Panel. You can choose to export part of the file by pressing the "Change” button and specifying a
start time and an end time (using displacement times or absolute times) on the dialog box below.
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Security - By default, any sealed sections of the recording within the file, or part of the file, being exported,
will be deleted. You can use the “Change security” button to change this behavior. For more information,
see "Working with Sealed Recordings".
Redaction - From the drop-down list, you can select the handling of redacted segments. All of them can be
skipped (not included), blacked out, or ignored (included), or each individual bookmark setting can be
used.
Speech enhancements - as part of the export process, you can use Automatic Gain Control (AGC) to
control the sound level of speech recording during playback and use noise suppression to enhance the
quality of reproduced sound by suppressing unwanted noise in a recording. By default, both of these
options are selected. Click the “Change Enhancements” button to clear either of these options.
Select Video - This button appears if the dcr file has more than one video stream. By default, all video
streams are exported. Click this button if you want to limit which video streams are exported.
Disc title - Optionally, you can change the title of the disc. The title will appear on the main menu of the
disc.
5. Click the Burn button.
DCR Player will burn the disc, eject it when it is complete, and prompt you to make another copy. Bookmarks
and Notes will appear on the main menu of the video DVD. The maximum number of bookmarks is 99.

3.14

Exporting a File to PDF Format
You can export the data in a dcr file to PDF format. This PDF file can then be browsed using Adobe Acrobat
Reader. You can choose to export part of a file by specifying a time range or export the entire file. The media file
can be created and saved separately from the PDF document so that the audio/video links will work properly
after you move the file onto a Windows Media Server folder to be streamed to the end users.
All of the data, including file notes, bookmarks, audio, and video can be exported to the PDF file. If you export
any of the media, green arrows in the PDF file indicate bookmark positions, as shown below. You can click on
any of these arrows and playback will jump to that point in the file and launch Windows Media Player.
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To export a dcr file to PDF format, take the following steps:
1. Open the file in DCR Player.
2. If you want to export only part of a file, it is recommended you use the Selection Panel to select the fragment
you want to export. You can adjust this selection later in this process if you need to.
3. Choose File - Export to Adobe PDF. The following dialog box appears.
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4. Select whether you want to export the file to a hard disk or burn the file to a media disc.
5. Complete the fields described below.
Target information: When exporting to your hard disc, you can specify the “Target file” name and location.
When burning to a media disc, you will need to specify the “Target drive” and “Disc type”.
Media format - Optionally, you can use the “Change Format” button to change the media format.
Selection - By default, the entire file will be exported unless you have selected part of the file on the
Selection Panel. You can choose to export part of the file by pressing the "Change Selection” button and
specifying a start time and an end time (using displacement times or absolute times) on the dialog below.
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Security - By default, any sealed sections of the recording within the file, or part of the file, being exported,
will be deleted. You can use the “Change security” button to change this behavior. For more information,
see "Working with Sealed Recordings".
Redaction - from the drop-down list, you can select the handling of redacted segments. All of them can be
skipped (not included), blacked out, or ignored (included), or each individual bookmark setting can be
used.
Include data - choose which media to export. You can export the audio and video, the audio only, or neither
the audio nor the video. You can use the “Change Including” button to change additional options on the
dialog below.
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Media file - you have the following options:
Embed into PDF file - select this option if you want the media file embedded in the resulting PDF
document.
Create separately WMA/WMV file - select this option if you want the media file to be created and saved
separately from the PDF document. Initially, it will be saved into the same folder as the PDF document with
the intention of later moving it onto a Windows Media Server folder to be streamed to the end users. In the
"Prefix" field, specify the URL associated with the media server folder and not the folder on the PC to which
it is initially saved. For example: mms://server/connection_point/subfolder. This enables the audio/video
links in the PDF document to work properly after you move the media file to the media server.
Speech enhancements - as part of the export process, you can use Automatic Gain Control (AGC) to
control the sound level of speech recording during playback and use noise suppression to enhance the
quality of reproduced sound by suppressing unwanted noise in a recording. By default, both of these
options are selected. Click the “Change Enhancements” button to clear either of these options.
Add files in this folder to the export or CD/DVD - select this check box if you want to include additional
files. Specify the location of the folder containing these files in the field below. All files and subfolders from
this folder will be added to the disc. For a CD/DVD, the size of these files cannot exceed half of the
available space on the disc. If a recording spans multiple discs, these additional files are copied to each
of the discs.
For example, you can use this field if you have created a portable version of the Player program on a CD/
DVD and want to include the PlayerProgram folder on the disc.
Add logo image to PDF file - if you want to include a logo image in the PDF file, select this option and then
specify below the location of the image. The following formats for the logo image are supported: jpg, png
and bmp. The image will appear centered horizontally at the beginning of the PDF document and it will be
scaled by 65%.
6. Click Export or Burn.
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Exporting a file to PDF format may take a long time. A progress bar indicates the status and the title bar shows
the percentage of the file exported.

3.15

Exporting a File to MP4 Format
You can export the audio and video in a dcr file to MP4 format. This file can then be played using a product such
as Windows Media Player.
Using this export facility you can also create a portable version of a recording file by choosing to create a
separate meta-data file. In addition to the MP4 file, an html file will be created that you can view through a
browser of your choice. This allows you to play the video, listen to the audio, and use bookmarks within the file.
To export a dcr file to MP4 format, take the following steps:
1. Open the file in DCR Player.
2. If you want to export only part of a file, it is recommended you use the Selection Panel to select the fragment
you want to export. You can adjust this selection later in this process if you need to.
3. Choose File - Export to MPEG-4. The following dialog box appears.
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4. Select whether you want to export the file to a hard disk or burn the file to a media disc.
5. Complete the fields described below.
Target information: When exporting to your hard disc, you can specify the “Target folder” location. When
burning to a media disc, you will need to specify the “Target drive” and “Disc type”.
Selection - By default, the entire file will be exported unless you have selected part of the file on the
Selection Panel. You can choose to export part of the file by pressing the "Change Selection” button and
specifying a start time and an end time (using displacement times or absolute times) on the dialog below.
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Security - By default, any sealed sections of the recording within the file, or part of the file, being exported,
will be deleted. You can use the “Change Security” button to change this behavior. For more information,
see "Working with Sealed Recordings".
Redaction - from the drop-down list, you can select the handling of redacted segments. All of them can be
skipped (not included), blacked out, or ignored (included), or each individual bookmark setting can be
used.
Include video - select this check box if you want to export video to the file. You can click the “Select Video”
button to select the video streams to be exported and how you want them displayed (a picture within a
picture, for example).
If you want multiple video streams saved to the MP4 file without being merged into a single video stream,
select the “Retain multiple independent video streams in MP4 file” check box. Note that not all browsers
support the ability for you to select and playback any of the multiple streams. You can also identify one
stream as the main stream. This is the stream that will be displayed when using a browser that cannot
switch between video streams.
Create separate meta-data file (recommended) - it is recommended you select this check box to have a
separate meta-data file created. This will result in the creation of an MP4 file, an html file, and a Metadata
folder in a subfolder with the same name as the file name (without an extension). This also includes a
control that allows you to switch between video streams if supported by your browser (e.g. Microsoft
Edge).
Speech enhancements - when exporting to a non-DCR format, you can use Automatic Gain Control (AGC)
to control the sound level of speech recording during playback and use noise suppression to enhance the
quality of reproduced sound by suppressing unwanted noise in a recording. By default, both of these
options are selected. Click the “Change Enhancements” button to clear either of these options.
Add files in this folder to the export or CD/DVD - select this check box if you want to include additional
files. Specify the location of the folder containing these files in the field below. All files and subfolders from
this folder will be added to the disc. For a CD/DVD, the size of these files cannot exceed half of the
available space on the disc. If a recording spans multiple discs, these additional files are copied to each
of the discs. For example, you can use this field if you have created a portable version of the Player
program on a CD/DVD and want to include the PlayerProgram folder on the disc.
6. Click Export or Burn.
Exporting a file may take a long time. A progress bar indicates the status and the title bar shows the
percentage of the file exported.
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Using the Command Line
DCR Player can be run from the command line.
The syntax to run DCR Player from the command line is:
DcrPlayer.exe [Filename] [-Play] [-Minimize]
The parameters are explained below:
[Filename] - specifies the name of a file you want DCR Player to open. Include the full path to the file. If the path
contains spaces, enclose it in double quotes.
[-Play] - indicates you want to start playback. You can abbreviate this parameter as [-p].
[-Minimize] - indicates the program should run in minimized mode. You can abbreviate this parameter as [-m].
Example
The following example opens a file and playback.
DcrPlayer.exe "a file" -p

3.17

Associating DCR Files with a Digital Program
DCR files are automatically associated with either Digital Recorder or DCR Player. When you double-click on a
DCR file name in Windows Explorer, the associated program is automatically opened.
If required, you can manually associate DCR files with DCR Player. For example, this may be required when
both Digital Recorder and DCR Player are installed and you want DCR files to be automatically associated with
DCR Player instead of Digital Recorder.
To manually associate DCR files with a Digital program, take the following steps:
1. From the program you want to use as the default, choose "View - Options".
2. Select the "General" tab.
3. Press the “Advanced” button.
4. Click the “Associate program with DCR files” button. For Windows 8 users, this will launch a system dialog
where you can set the association. For prior Windows systems, clicking the button is sufficient.

3.18

Analyzing a DCR File
DCR Player has a built-in utility to analyze a DCR file and to validate its integrity. When problems occur with a
DCR file, Technical Support may ask you to analyze the file, by taking the following steps.
1. From the Help menu in DCR Player, click "Analyze DCR File". The following dialog box appears.
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2. In the "DCR file to be analyzed" field, specify the full path to the file to be analyzed, or click the
locate and select the file.

button to

3. Click the "Start" button.
When the analysis is complete, a dialog box appears with a summary of the results. If a problem is found
during the analysis, Technical Support may ask you to select "Use log file" and "Copy footer to file" on the
"Analyze DCR File" dialog box, rerun the analysis, and send them the resultant files. These files can help the
Technical Support Team determine and resolve problems associated with the DCR file.
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Collecting Trace Information
To help identify and diagnose problems, DCR Player can collect diagnostic, or trace, information. You can set
different types of traces when advised by the Technical Support Team.
Technical Support may ask you to collect information for a problem, by taking the following steps.
1. From the Help menu, click Debug. The following dialog box appears.

2. Technical Support will advise you which options to select on this dialog box.
Each program collects and stores a limited amount of trace information in hidden files so that when a problem
does arise, there is already some trace information available. When you indicate that trace information is to be
stored in a file, the program copies trace information from a hidden file to the file you specify.
You can use the Open Folder button to open the Debug folder. You can use the View button to view system
information or the contents of a trace file.
Trace information is automatically cleaned up. Information which is older than 7 days is automatically purged
from the General trace file. You can use the Clear button to manually clear a trace file.
Note: When you install DCR Player, a folder called “Debug” is created in the program’s installation directory.
You should not delete this folder. If you accidentally delete it, you will need to run the install program again and
select the “Repair” option.
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Keyboard shortcuts
Use the shortcut keys for quick access to common commands.
You can use the following shortcut keys in the Main window:

Description

Shortcut Key

Button

Open an existing DCR file

Ctrl + O

File - Open

Play

Ctrl + P

Playback - Play

Pause / continue

Ctrl + U

Playback - Pause

Stop

Ctrl + T

Playback - Stop

Play all channels

Ctrl + 0

Playback - Playing All Channels

Play a specific channel

Ctrl + (1-8)

Playback - Playing Channel (n)

Decrease the playback speed

Ctrl + Shift + D

Playback - Speed Play - Decrease

Restore the normal speed

Ctrl + Shift + N

Increase the playback speed

Ctrl + Shift + I

Playback - Speed Play - Increase

Playback with automatic pauses

Ctrl + Q

Playback - Automatic Pauses

Change the autopause parameters

Ctrl + Alt + Q

Playback - Autopause Parameters

Rewind to the beginning

Ctrl + H

Playback - Go To - Home

Left (one step)

Ctrl + L

Playback - Go To - Left

Right (one step)

Ctrl + G

Playback - Go To - Right

Go to end

Ctrl + E

Playback - Go To - End

Jump to a time

Ctrl + J

Playback - Jump To Time

Jump to next activity in channel n

Ctrl + Shift + n

Playback - Jump to Next Activity Channel n

Set the left selection boundary to the
current slider position

Ctrl + Shift + P

Selection - Set Beginning of Selection

x1

Menu

Playback - Speed Play - Normal

Set the right selection boundary to the Ctrl + Shift + T
current slider position

Selection - Set End of Selection

Export to WMV, WAV, AVI or DCR file

Ctrl + Shift + E

File - Export

Change configuration options

Alt + F7

View - Options

Show or hide the Bookmarks window

Alt + F2

View - Bookmarks

Switch to the Thin View

Alt + F5

View - Thin View

You can use the following shortcut keys in the Bookmarks window:
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Description

Shortcut Key

Button

Menu

Create a new bookmark

F2

Edit - New Bookmark

Find text in bookmarks

Ctrl + F

Edit - Find

Move current position to previous
bookmark

Shift + F4

Position - Go to Previous

Move current position to current
bookmark

F4

Position - Go to Current

Move current position to next
bookmark

Ctrl + F4

Position - Go to Next

103

104

DCR Player

Index
-Aabbreviation
55
activity
42
Adobe PDF
91
AGC
19, 41, 84, 87, 89, 91, 96
algorithm
79
always on top
46
analyze
99
assistive
46
association
99
audio CD
87
audio device
19
auto
72
automatic face tracking
67
Automatic Gain Control
84, 87, 89, 91, 96
automatic pauses
19, 38, 39
autopause parameters
39
AVI 84

-Bbass
41
black out
30, 64, 89
BMR file
75
bookmark
25, 28, 55, 60, 63, 70, 71, 72, 73, 74, 75,
76, 77, 78, 79, 82
burn
87
burning
31

-CCAD
42
calculation
67
case
28
ccommand line
99
certificate
50
channel
43, 46
Channel Activity Detector
clipboard
77
close
25
closest
75
color
60, 78
columns
55

COM port
52
component
16
configuration
17
configuring
18, 19, 21, 22, 23, 24, 25, 27, 28, 32, 53
constant region
67
copy
77
copyright
16
create
60
customize
33, 55

-Ddate
79, 82
DCR
84, 87, 99
debug
101
decrease speed
40, 46
default
18
default program
99
delete
55, 60
detection
67
detector
42
device
19, 24, 54
digital certificate
50
distortion
30, 64, 67, 89
docket
28, 55
dockets
79
DVD
31, 89

-Eencrypt
71
engine
31
entire frame
67
event
24
export
32, 71, 76, 84, 87, 89, 91, 96

-F-

42

face
67
feature
4
field
28
file
59, 82
file notes
25, 73, 74, 77, 78
file size
87
file type
99
filename
99
filter
41
find
55, 73, 74, 75, 79, 82

Index

folder
25
folders
79, 82
font
78
foot control
24, 52, 53
foot control wizard
24, 54
foot pedal
24, 52, 53, 54
footer
78
forward
53
functions
24, 52, 53

-Llevel
41, 43, 49
LightScribe
89
listen-only
25
load
22
lock
71
low-cut
41

-G-

-M-

gain
19, 41
game port
52
global hot key
23

manual face tracking
67
mapping
54
match case
74
media server
91
menus
33
meta-data
96
minimize
22, 25, 99
mirrored file
39
mirroring
45
mixed mode
43
monitor
16
MP3
87
MP4
96
MPEG-2 format
31, 89
msi
17
multiple
42

-Hheader
78
highlight
60
history
63
hot key
23, 102

-IIIS
45
image
49
import
17, 32, 75
increase speed
40, 46
Indexing Service
82
information
5, 6, 7, 12
insert
70
install
17
international characters
70
Internet Information Services
interval
55

-Jjump

42, 72

-Kkeep position
19
keeping
72
key
102
keyboard
102
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-N45

navigation
75
network
44, 45
new
5, 6, 7, 12, 55, 60
noise
41, 84, 87, 89, 91, 96
normal speed
40, 46
notes
59
number of pedals
24

-Oonline
39
open
45
open file
46
options
18, 19, 21, 22, 23, 24, 25, 27, 28, 32, 53
overview
4
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-P-

-S-

page numbers
78
password
27
pause
38, 39, 46
PDF
91
pedal
24, 52, 53, 54
pedal functions
24, 52, 53
phonetic
79
phrase
73, 79
picture
38
play
19, 21, 22, 38, 39, 40, 41, 42, 43, 44, 45, 46,
52, 53, 99
PlayActiDcrDll
45
playback
19, 21, 44, 45, 52, 54
player
16, 33
port
52
portable
51
position
55, 60, 72, 75
prefix
91
print
78
priority
25
private
60
private key
50

scroll
55, 75
seal
27, 55, 60, 71, 84, 87, 89
search
79, 82
Section 508
46
security
27, 84, 87, 89
segment
30, 64, 67
select
76, 77, 78
selection
45, 84, 87, 91, 96
sensitivity
42
service
82
setup
17
shortcut
102
sign
50
skip
30, 64, 89
solution
16
sound
49
sound card
19
speaker
42
special
75
special character
70
speech
19, 41, 84, 87, 89, 91, 96
speed play
21, 38, 40, 46
split
87
start
38, 46, 52
startup
22
step
52
step back
19, 38, 39, 53
step forward
53
stereo
38
stop
38, 46, 52
subfolders
79, 82
support
99, 101
switch channel
53
symbol
70
system tray
25

-Qquality

41

-Rrecorder
16
redaction
30, 38, 64, 67, 84, 87, 89, 91, 96
region
67
Rehabilitation Act
46
remove
18
replace
74
reposition
60
requirement
16
restore
18
results
79, 82
resume
38, 39, 46
rewind
53

-Ttask bar
25
temporary folder
25
text
59, 73, 74, 79, 82
text file
76, 78
thin view
46
time
72
Time Stamp Authority
50

Index

title
28, 55, 78
tone
41
toolbar
33, 55
trace
101
trademark
16
treble
41
TSA
50

-Uuninstall
18
unseal
60
URL
44, 45
USB port
52

-Vverify
50
version
5, 6, 7, 12
video
33, 38, 89
video DVD
31
voice
19
volume
41

-Wwav 84, 87
wave device
19
Windows Media file
84, 91
Windows Search
82
wizard
24, 54
WMA
84, 91
WMV
84, 91
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